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1 Safety Messages and Proper Use of the Smart view
1.1 Important Definitions

1 Safety Messages and Proper Use of the Smart
view
1.1 Important Definitions

The types of messages shown below serve the safety of life and limb as well as for the
appropriate operating life of the device.

DANGER! indicates an immediately dangerous situation that will result in death or
serious injury if it is not avoided.

WARNING! indicates a hazardous situation that can result in death or serious injury if it is
not avoided.

CAUTION!

f CAUTION! indicates a possibly hazardous situation that can result in minor or moderate

injuries if it is not avoided.

NOTICE!

' NOTICE! is used to address practices not related to personal injury.

O This symbol indicates useful tips and recommendations as well as information for
l efficient and trouble-free operation.

[e)]
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1 Safety Messages and Proper Use of the Smart view
1.2 Proper Use of the Device and of This Manual

1.2 Proper Use of the Device and of This Manual

FOLLOW INSTRUCTIONS

Read this entire manual and all other publications pertaining to the work to be performed
before installing, operating, or servicing this equipment. Practice all plant and safety
instructions and precautions. Failure to follow instructions can cause personal injury

and/or property damage.
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1 Safety Messages and Proper Use of the Smart view
1.3 Important Information

1.3 Important Information

Out-of-Date Documentation?

Q This publication may have been revised or updated since this copy was produced. To
l verify that you have the latest revision, please visit the download section of our website:

* https://docs.SEGelectronics.de/smart_view
Please check this download area for the latest revision of this Technical Manual and

whether there is an Errata Sheet with updated information. (The ID of every document is
printed on its cover page.)
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2 Introduction to Smart view

2 Introduction to Smart view

Smart view is a parameter setting and evaluation software.
It is primarily intended to be connected with devices from the HighPROTEC family of
protection devices, and therefore this is the main focus of this manual, especially because
the devices from this series offer the most complexity and feature-richness. However, there
are also a lot of protection devices from the HighTECH Line, the Professional Line and the
WI Line series supported. SEG will continue to add support for more and more devices (plus -
of course - further enhancements in general); therefore it is worthwhile making sure to
always have the latest Smart view version installed.
However, please be aware that not all functionality described in this manual is available
for every device; only those features can be used that are actually supported by the
connected device.
The full feature set, as available with HighPROTEC devices, comprises:

* Menu-controlled parameter setting incl. validity checks

» Offline configuration of all relay types

¢ Reading and evaluating of statistical data and measuring values

» Setting into operation assistance

» Display of the device status

¢ Fault analysis via event- and fault recorder

' Smart view 3.0 or higher supports reading parameter files generated by older versions of

Smart view. Parameter files generated by Smart view 3.0 and higher cannot be read by
older versions of Smart view.
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2 Introduction to Smart view

2.1 Installation of Smart view

2.1

Installation of Smart view

NOTICE!

The TCP/IP ports in the range 52152 ... 52163 must not be blocked by a firewall, and
none of these ports must be used by any other (non-SEG) application.

(This requirement persists regardless of the connection type that will be actually used,
i.e. also for USB connections.)

10

System Requirements

Windows 10 and later (upgraded to the latest officially available status)

Setup

The Smart view setup file is available on the product DVD, that is part of the delivery of
the protective device. The setup program “Smartview SE Install.exe”iscontainedinthe
“Smart view SE” folder of the product DVD.

In addition, the Smart view setup can also be retrieved from the SEG download area:
docs.SEGelectronics.de/smart_view

To install Smart view:
* Double-click on the installation file with the left mouse button.
* Select a language for the installation procedure.
¢ Confirm by pressing the »Continue« button in the INFO frame.

* Select an installation path or confirm the standard installation path by mouse click
on the »Continue« button.

* Confirm the entry for the suggested installation folder by mouse click on
the »Continue« button.

¢ By mouse click on the »Install« button, the installation routine is started.
¢ Close the installation procedure by mouse click on the »Complete« button.

Now you can launch the program via [Start / Programs / SEG / Smart view].

If the Windows User Access Control pops up while installing Smart view, please “Allow” all
installation requirements concerning Smart view.

If DLLs should be Missing

If Smart view should refuse to start because of missing DLLs then your Windows PC needs
to have the “Visual C++ 2017 Redistributable (x86)” package installed.

You can get this package either from our download area at docs.SEGelectronics.de/
vc_redist x86, or directly from Microsoft.

Smart view SMARTV-5.50-EN-MAN
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2 Introduction to Smart view

2.1 Installation of Smart view
Switching the Language of the Graphical User Interface

Within the menu [Settings / Language], you can change the language of the graphical
user interface.
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2 Introduction to Smart view

2.2 Silent Installation

2.2

Silent Installation

In some cases it is required to perform an unattended (“silent”) installation. For example,
an IT department might want to remotely install or upgrade Smart view without the PC user

being distracted by dialog windows.

The setup program features a special “silent” mode for this purpose, which is entered if
command-line options are given as follows:

* Smartview SE Install.exe /SILENT

This command performs a “silent” installation of all Smart view-related applications

including USB driver, and there is no user interaction needed for the installation
process. However, the Installation Progress window is visible during the installation
process.

* Smartview SE Install.exe /VERYSILENT
This command performs a “very silent” installation of all Smart view-related
applications including USB driver: There is no user interaction needed for the
installation process, and no dialog or window is visible.
The SILENT and VERYSILENT options may be used with another option, UNINSTOLD.
* Smartview SE Install.exe /SILENT /UNINSTOLD

Smartview SE Install.exe /VERYSILENT /UNINSTOLD

In addition to the “silent” and “very silent” installation described above, it is checked

whether there are any previous (“old”) versions of Smart view installed, and if this
is the case then the previous version(s) are uninstalled (also in a “silent” manner,
without any user interaction).

Note that additional preparations might be necessary to let the installation process
run seamlessly; in particular, the “UAC” (User Access Control) dialog of the Windows
operating system has to be managed via the “Microsoft System Center” and the
“Microsoft Group Policy”.

12
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2 Introduction to Smart view

2.3 Uninstall Smart view

2.3 Uninstall Smart view

Via the usual Software/Apps Control Panel Smart view can be removed from your computer.

2.4 Optional Accessories

The type of cable required for the connection is dependent on the type of protective device.
The cables are not part of the product delivery, but can be ordered separately from SEG.

;
N Qk /

N \ fy ¢
USB cable, for protective Null Modem cable, for USB/Serial adaptor, for
devices with USB front protective devices with RS232 protective devices with RS232
connector. front connector. front connector and PC
without RS232 connector.
SEG article: SEG article:
SEG article:
5450-1946 COMRS232Nulim
USB2RS232ADAP

2.5 Program Exit

You quit Smart view by clicking the menu item [File / Exit] or, alternatively, clicking
the »Exit« icon (“IXI") top right of the window, as usual with Windows applications.

If any modifications have been made in a currently loaded parameter setting file, you are
asked to save these changes.

If a device is still connected, this connection will be closed.

SMARTV-5.50-EN-MAN Smart view 13



3 Setting up the Connection between PC and Device

Setting up the Connection between PC and
Device

The menu item [Settings / Device Connection] allows for selecting the type of connection
that is used for connecting Smart view with a protection device. There are various options:

HighPROTEC (Version 3.x) USB connection, see <3.1 Connect a HighPROTEC Device
via a USB Cable.

HighPROTEC: Ethernet connection, see -+3.2 Connect a HighPROTEC Device via
TCP/IP (Ethernet).

HighPROTEC (Version 2.x): Serial connection, see 3.4 Connect a HighPROTEC
Device via a Serial RS232 Interface.

WI Line (V2): USB connection, see -+3.5 Connect a WIC1 (2nd Generation) via
DiggiMEC.

HTL3/PL/WIP device connection, which is used for connecting with a protection
device from the High Tech Line, the Professional Line or WI Line (15t generation)
series; see -3.6 Connect a HIghTECH Line Device and 3.7 Connect a Professional
Line Device.

If a firewall is installed on your computer, make sure that no TCP/IP port in the range
52152 ... 52163 is blocked. (This is required for all connection types listed here.)

14

Secured Communication

Only for HighPROTEC devices as of Version 3.4: For security reasons, it is possible
to restrict or disable the connection between Smart view and the HighPROTEC device. Of
course, the following descriptions assume that the access has not been blocked.

Only for HighPROTEC devices as of Version 3.6: Moreover, a connection is established
only after a connection password has been entered. Finally, the connection is fully
encrypted, and certificates guarantee the correct identity of the communication parties. The
user, however, need not take care of the encryption, this is established automatically in the
background. (See the “Security” chapter of the device manual for details.)
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3 Setting up the Connection between PC and Device
3.1 Connect a HighPROTEC Device via a USB Cable

3.1 Connect a HighPROTEC Device via a USB Cable

Protective Relay

High PROTEC EEE

USB Cable
5450-1946

Smart view

tV_204

Fig. 1: Parameter setting and evaluation via USB cable.

NOTICE!

' For HighPROTEC devices as of Version 3.4 it is possible for security reasons to disable
o

this connection type (though the factory default is that it is set active). Of course, the
following description assumes that the access has been activated.

Please install Smart view in case that it has not yet been installed on your PC.
Connect your PC/notebook via a USB cable with a powered/running device.
Start Smart view.

Select the menu point »Device Connection« in menu »Settings«.

Within this menu select the communication option USB connection.

Within the Drop-Down-Menu select the connected USB device.

S I I I S R
VVVVVVYV

If a confirmation dialog “The selected connection is currently not installed. Should this
connection be used for device communication?” opens, confirm this by pressing “Yes”.

Only for HiIghPROTEC devices as of Version 3.6: Remember that later, while
establishing a connection, Smart view might ask for a connection password (“USB
connection”, unless this has been set empty). See »“Secured Communication”, <“Change
Passwords via Smart view” and the “Security” chapter in the Technical Manual of the relay.
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3 Setting up the Connection between PC and Device
3.2 Connect a HighPROTEC Device via TCP/IP (Ethernet)

3.2 Connect a HighPROTEC Device via TCP/IP (Ethernet)

Mixing up IP-Addresses (In case that there is more than one protective device within the
TCP/IP network). Establishing an unintentional wrong connection to a protective device
based on a wrong entered IP-Address. Transferring parameters into a wrong protective
device might lead to death, personal injury or damage of electrical equipment.

In order to prevent faulty connections the user has to document and maintain a list with
the IP addresses of any switchboard/protective device.

The user has to doublecheck the IP addresses of the connection that is to be established.
That means, the user must first read out the IP address at the HMI of the device (within
menu [Device Para / TCP/IP / TCP/IP config]), then compare the IP address with the list. If
the addresses are identical, establish the connection. Otherwise do not connect.

Protective Relay
soom

I High PROTEC EEE B

IP Address

TCP/IP Cable
Ethernet R)45

Smart view

Smartv_z03

Fig. 2: Parameter Setting and Evaluation via TCP/IP.

NOTICE!

' Establishing a connection via TCP/IP to the device is only possible if your device is
o

equipped with an Ethernet interface.
Contact your IT administrator in order to establish the network connection.
For HighPROTEC devices as of Version 3.4 it is possible for security reasons to disable

this connection type. Of course, the following description assumes that the access is
permitted.
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3 Setting up the Connection between PC and Device
3.2 Connect a HighPROTEC Device via TCP/IP (Ethernet)

Part 1: Set the TCP/IP Parameters at the panel (Device).

Enter the menu branch [Device Para / TCP/IP / TCP/IP config] at the HMI (panel) and set the
following parameters:

e TCP/IP address
¢ Subnet mask

* Gateway

Part 2: Setting the IP address within Smart view

1. > Enter the menu [Settings / Device Connection] within Smart view.
2. > Select the button »Ethernet-Connection«.

3. > Enter the IP-Address of the device that should be connected.

Only for HighPROTEC devices as of Version 3.6: Remember that later, while
establishing a connection, Smart view might ask for a connection password (“Remote
network connection”, unless this has been set empty). See »“Secured Communication”,

<“Change Passwords via Smart view” and the “Security” chapter in the Technical Manual of
the relay.

SMARTV-5.50-EN-MAN Smart view 17



3 Setting up the Connection between PC and Device
3.3 Connect a HPT Device via Modbus Tunnel

3.3 Connect a HPT Device via Modbus Tunnel

In general we recommend to prefer a connection via TCP/IP over the Modbus Tunnel if
your protection device is equipped with an Ethernet interface. (The connection via TCP/IP is
described in 3.2 Connect a HighPROTEC Device via TCP/IP (Ethernet).)

~ Smart view

< > IP Address

TCP/IP Cable
Ethernet RJ45

Power Xpert Gateway

R
X
(9}
Y
o
=]

Modbus RTU

¥ Modbus RTU ¥ ¥ Modbus RTU ¥

High PROTEC EEE High PROTEC EER High PROTEC EEE

artv_z05

Slave ID 2 Slave ID 3 SlaveIDn |
Fig. 3: Connection principle via Modbus Tunnel.
NOTICE!

Connections via Modbus Tunnel are possible only with the setting [Device Para / Modbus /
Config. Data Obj.] »Type of SCADA mapping« = “Standard”.

In other words, this connection type is not compatible with user-defined datapoint
mappings.

CAUTION!

Exception: For technical reasons, neither encryption nor an exchange of certificates is
possible for a Smart view connection via Modbus Tunnel. Therefore this connection type
is deactivated by default.

Moreover, we strongly recommend to define a non-empty, non-standard Access Level

Password to guarantee some minimum security. (See the “Security” chapter in the User
Manual of the protection device.)
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3 Setting up the Connection between PC and Device

3.3 Connect a HPT Device via Modbus Tunnel
Part 1: Set the Parameters at the Device.

The protection device that shall be connected via Modbus Tunnel needs to have a unique
Slave ID. It can be set (or read out in case it has already been set) at the panel after entering
the menu branch [Device Para / Modbus].

Moreover, check the settings at [Device Para / Modbus / Communication / RTU], in particular
the timeout value: If a too short value is set then establishing the connection might fail.
We recommend a timeout of at least 1.5 seconds. (Don't forget to also compare it with the
Modbus timeout value of the Gateway: It must not be shorter than the timeout setting of the
protection device.)

Finally, all connections via Modbus Tunnel might be deactivated. At least this is the factory
default, see Caution message above and the “Security” chapter in the User Manual of the
protection device.

This connection type is activated by the setting [Device Para / Security /
Communication] »Smart view via Modbus« = “Active”.

Part 2: Settings using Smart view
¢ Enter the menu [Settings / Device Connection] within Smart view.
* Select »Modbus TCP/IP Gateway«.

* Enter the IP-Address of the Modbus gateway (Power Xpert Gateway).

Enter the Slave ID of the protection device.

e Enter the Modbus TCP Port (if it is different from the standard port 502).

SMARTV-5.50-EN-MAN Smart view 19



3 Setting up the Connection between PC and Device
3.4 Connect a HighPROTEC Device via a Serial RS232 Interface

3.4 Connect a HighPROTEC Device via a Serial RS232 Interface

NOTICE!

' The serial connection described here is applicable only for older HighPROTEC protection
o

devices (until Version 2.5).

As of Version 3.0, all HighPROTEC protection devices have a USB interface, instead of
RS232. (Therefore the description in ©3.1 Connect a HighPROTEC Device via a USB Cable
is applicable for these.)

From this follows that this connection type is available only for HighPROTEC devices that
do not support any IT security aspects (encryption, certificates).

v
N
b )
Smartv_z23

Null Modem cable

SEG article:

COMRS232Nullm

After installation of the Smart view, the »Connection PC/Notebook to the Device« has to be

configured once so that you are able to read device data or re-write them into the device by
means of Smart view.

NOTICE!

' For connection of your PCs/notebooks with the device, you need the following equipment:
®

* a zero-modem cable (SEG article “COMRS232Nullm”, no serial cable)!
Please refer to chapter »Zero Modem Cable« within the device manual.

¢ If your PC/notebook does not have a serial interface, you need a special »USB-to-
serial-adapter« (SEG article “USB2RS232ADAP”).

Only if the »USB-to-serial-adapter« is correctly installed - aided by the provided
CD - the communication with the device can be established. (See =“Setting up/
Configuring the Connection”.)

"!
SmartV_z24

Smartv_z23

USB/Serial adapter

Null Modem cable SEG article:

USB2RS232ADAP
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3 Setting up the Connection between PC and Device
3.4 Connect a HighPROTEC Device via a Serial RS232 Interface

SEG article:

COMRS232Nullm

Setting up/Configuring the Connection

1. > Connect your PC/notebook with the device via a zero-modem cable.
Start the software Smart view.

Select the menu point »Device Connection« in menu »Settings«.
Click on »Serial Connection«.
Select the serial interface (COM-Port) where the device shall be connected to.

Confirm the adjustments by clicking the »OK« button.

= S
vVVVVYV

If the interface is chosen for the first time, a popup window will appear “The selected
connection is currently not installed. Should this connection be used for device
communication? “.

6. > Confirm this by pressing the “Yes” button.
Establishing the Connection via a USB-/RS232-Adapter

If your PC/notebook is not provided with a serial interface, this can be compensated by a
special USB-/RS232-Adapter+Zero Modem-Cable.

' Only an adapter accepted by SEG is to be used (USB2RS232ADAP). First install the adapter

(with the related driver that you can find on the CD) and then establish the connection
(Smart view => Device). The adapters must support very high speed.
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3 Setting up the Connection between PC and Device
3.5 Connect a WIC1 (2nd Generation) via DiggiMEC

3.5 Connect a WIC1 (2nd Generation) via DiggiMEC
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Smart view \
Fig. 4: Connection of a WIC1 protection device via DiggiMEC with a PC.

NOTICE!

* a DiggiMEC.

e a USB cable with a plug of type USB-C (and at the other end a USB plug that is
available at your PC).

' For a connection of your PC/notebook with a WIC1, you need the following equipment:
®

* In case the DiggiMEC is not connected to the WIC1 yet:

a network cable with two RJ45 plugs, class CAT3 or better. Crossover cables must
not be used!

CAUTION!

Note that you must not use this cable to directly link the WIC1 (or a DiggiMEC) to your
PC!

Although WIC1 and DiggiMEC communicate with each other via a network cable, this is
based on a proprietary protocol and not an Ethernet connection.

Setting up/Configuring the Connection
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3 Setting up the Connection between PC and Device
3.5 Connect a WIC1 (2nd Generation) via DiggiMEC

1. > Make sure the DiggiMEC is connected to the WIC1, then use the USB cable to connect
the DiggiMEC to your PC/notebook.
A USB interface of a common PC/notebook is able to supply both DiggiMEC and WIC1, in
case they are not supplied by the CTs.

Start the software Smart view.
2. > Select the menu point »Device Connection« in menu »Settings«.
3. > Click on »WI Line DiggiMEC USBx«.

p This selects the interface (COM-Port) where the device is connected.
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3.6 Connect a HighTECH Line Device

3.6 Connect a HIghTECH Line Device
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Fig. 5: Connection of a HighTECH Line protection device with a PC.

NOTICE!

For a connection of your PCs/notebooks with the device, you need the following
equipment:
o

e an »RS485 to RS232 adapter« (any supplier), and
e a zero-modem cable (SEG article “COMRS232Nullm”, no serial cable)!

* |In case your PC/notebook lacks a serial interface you also need a special »USB-to-
serial-adapter« (SEG article ,,USB2RS232ADAP“).

Setting up/Configuring the Connection

1. > Connect your PC/notebook with the device via a zero-modem cable and »RS485 to
RS232 adapter« (see diagram above).

Start the software Smart view.
> Select the menu point »Device Connection« in menu »Settings«.
3. > Click on »HTL3 / PL/ WIP Device Connection«.
>

Select the serial interface (COM-Port) that shall be used for the connection.
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3 Setting up the Connection between PC and Device

3.7 Connect a Professional Line Device

Connect a Professional Line Device

Professional Line devices exist in two types of housings, wide ones (typically named “XR...")
and small ones. Most of the wide ones are available with an RS485 interface so that they
can be connected to a PC in a similar manner as a HighTECH Line device. The small ones,

however, feature an optical interface. There is an adapter device named XRS1 available
for this.

Professional Line device

XRS1 Interface
Adapter

(only for a

Professional Line
device with optical

interface)

Table 1: Required Devices and Accessories

/

X

O A2

||”H':u

RS485-to-USB
adapter

SEG article:

RSC2485USB1 ...and:

e Two-wire cable (for
the RS485 bus)

e USB cable

The interface adapter XRS1 has to positioned directly besides the Professional Line device,
so that the optical interfaces of both devices are in direct optical contact one with the other.

xRS 1
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3 Setting up the Connection between PC and Device
3.7 Connect a Professional Line Device

SmartV_Z34

The XRS1 requires an auxiliary DC voltage in therange 19 V... 55 V, that must be connected
at terminal Al (negative pole L—) and A2 (positive pole L+).

The RS485 signal wires must be connected at terminals N and P.

Remark: Each terminal of the XRS1 exists twice: If there are several devices in use, it is
possible to simply lead through the wires. (See also the XRS1 User Manual.)

Windows PC XRS1 Professional Line
Device
T @ ® ® T I T
HHHEEL
@ @ @ L1 L2 L3 N Al A2 A3
USB connection 21 EE //:g OTHWWHW
ONE% ‘234;575 XU2-AC
— O xest||[| . SEE8EE  segsss cavone
IEIRSOFFE FEEEEE srpprr oiious
- e | ONAN AL (AL,
m [ k ! 24 21 22 14 11 12
u:1 ONONO)
2 oo ol LIJLILILILILIL
N
(®) A
n =
(-4
Optical
Interface
Fig. 6: Wiring for a Professional Line device with optical interface.
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3 Setting up the Connection between PC and Device

3.7 Connect a Professional Line Device

Windows PC

Professional Line
Device
(Large Housing)

USB Connection

H IELWE% 1E1 1E2 181 152 2581 252 381 352
@ S [Q SELECT/RESET] [Q - ]
=]
s 1234
brd L]
z 176087172 1 41 42 54 51 52 64 61 62 J1 1P 1N J2 Al = A2
Fig. 7: Wiring for a Professional Line device of type “XR” (large housing).
Setting up/Configuring the Connection
0]
1. > After the connection with the Windows-PC has been established launch Smart view.
2. > Select the menu point »Device Connection« in menu »Settings«.
3. > Clickon »HTL3/PL / WIP Device Connection«.
4. > Select the serial interface (COM-Port) that shall be used for the connection.
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3 Setting up the Connection between PC and Device
3.8 Troubleshooting during Setting up the Connection

3.8 Troubleshooting during Setting up the Connection
General
 If your problem is not covered by the general aspects listed below then it might
also be worth checking the “HighPROTEC Troubleshooting Guide”, or Chapter
“Troubleshooting” in the WIC1 User Manual (separate documents).

* If a firewall is installed on your computer, make sure that no TCP/IP port in the range
52152 ... 52163 is blocked.

Ethernet Connections

¢ Make sure that all TCP/IP data has been configured correctly (including the
configuration of the protection device).

* Check that the IP address of the protection device has been correctly entered in
Smart view.

* Note that currently only IPv4 addresses are supported.

Serial Connections (RS232) and USB Connections

¢ For establishing the connection, you need to have sufficient rights (administration
rights).

* Only for RS232: If your computer is not provided with a serial interface, you need
a USB-to-serial-adapter (SEG article “USB2RS232ADAP”). This adapter has to be
properly installed.
* Only for RS232: Ensure that a zero-modem cable is used (a standard serial cable
without control wires does not enable communication).
3.8.1 Persistent Connection Problems (*)

(*) applies only to serial connections (RS232) and USB connections

In case of persistent connection problems you should remove all connection settings and
establish them again afterwards. In order to remove all connection settings please proceed
as follows:

1. Remove the settings for the Dial-up Network

0

1. > Close Smart view

2. > Launch the »Control Panel«.

3. > Choose »Network & Internet«.

4. > On the left side, click on »Manage Network Connections«.

5. > Click on HighPROTEC Direct Connection with the right-hand mouse key.
6. > Choose »Delete« from the shortcut menu.

7. > Click on the »OK« button.
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3 Setting up the Connection between PC and Device

3.8.1 Persistent Connection Problems (*)

2. Remove the virtual modem

Launch the »Control Panel«.
Choose »Hardware & Sound«.
Choose »Phone & Modem Options«.
Go to Tab »Modem«.

Click on the correct (in case there is more than one) entry »Connection cable between
two computers«.

Click on the »Remove« button.
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4 Command-Line Parameters and Exit Codes

Command-Line Parameters

It is possible to start the Smart view application with additional command-line options.

All the options listed below are not case-sensitive. All these options may also start with a
slash character “/”, instead of a dash “-".

Option

-noLogo

-file: <filename>

-checkParameter

-minimize

-deviceModelFolder:
<directory>

-exportCSV: <filename>

-iec61850CreateSCD:
<filename>

-iec61850SendConfig:
<filename>

30

Description

This option suppresses the display of the sign-on banner (“splash
screen”) during the start-up phase of the application.

<filename> must be an existing parameter file. Smart view then
directly opens this file during the start-up phase.

A plausibility check (see =“Plausibility check”) is performed for the
currently loaded parameter data.

This options starts Smart view with a minimized main window.

<directory> must be an existing directory. Smart view then uses this
directory as standard repository for device model files.

Smart view creates a file in CSV-format from the currently loaded
setting data.

Example:

Smartview.exe -file:MySettings.HptPara
-exportCSV:MyData.csv

Smart view creates an IEC 61850 SCD file (Substation Configuration
Description) from the currently loaded setting data. The latest Edition
is used that the protection device supports (i.e. IEC 61850 Edition 2 -
or, if Ed. 2 is not supported, Edition 1).

Example:

Smartview.exe -file:MySettings.HptPara
-1ec61850CreateSCD:MyDev.scd

<filename> must be an existing and valid IEC 61850 SCD file. Smart
view sends the SCD file to the connected protection device.

Example:

Smartview.exe
-file:MySettings.HptPara
-1ec61850SendConfig:MyDev.scd
-password: 1234

This example command starts Smart view and makes it load

the existing parameter file MySettings.HptPara, connects to a
device (with the current connection settings). Then it creates the
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Option

-language: <Language-
ID>

-newFile: <param-
filename>

-deviceModel: <dm-
filename>

-paraKey: <param-key>

-paraValue: <param-
value>

-paraSetnumber:
<parameter-set>

-paraAdaptiveSet:
<adaptive-set>

SMARTV-5.50-EN-MAN

4 Command-Line Parameters and Exit Codes

Description

IEC 61850 configuration from the SCD file MyDev. scd and sends this
configuration data to the device.

Sets the language of the graphical user interface.

<Language-ID> must specify any of the supported languages:

e ENG (English)

e DEU (German)

e ESP (Spanish)

* FRA (French)

* PLK (Polish)

e PTB (Portuguese [Brazil])
* RUS (Russian)

e ROM (Romanian)

<param-filename> must be an non-existing parameter file.

<dm-filename> must be an existing device model file. (If no path is
specified then the standard device model path is used.)

Smart view writes a new parameter file from the specified device
model file. The result can be checked from the application exit code.

Example:

Smartview.exe -newFile:MySettings.HptPara
-deviceModel:MRA4 V3.4.a.dm _c

<param-key> is the case-sensitive internal description of the
parameter to be modified.

<param-value> is the new value of the parameter.

<parameter-set> is optional and valid only for Setting Group
Parameters. It can be the number of the parameter set to be used.
(Possible values: 0 [default], 1, 2, 3.)

<adaptive-set> is optional and valid only for Adaptive Parameters. It
can be the number of the adaptive set to be used. (Possible values: 0
[default], 1, 2, 3.)

Smart view writes a specific parameter setting value into the
currently loaded parameter file.

Example 1:

Smartview.exe
-newFile:MySettings.HptPara
-deviceModel:MRA4 V3.4.a.dm c

-paraKey:"/root/MDMs/CT 1 1/SingleSet/Current/CTprim"
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Option

-paraListFile: <txt-
filename>

32

Description

-paraValue: 1234

-quit
This example command starts Smart view and makes it create a
new parameter file MySettings.HptPara, then it assigns a new value
1234 of a particular parameter, and finally exits.
This example parameter belongs to the setting »CT pri« of the
nominal current of the primary side of the current transformers. (In
the graphical user interface of Smart view, this setting can be found
in the menu branch [Field Para / CT]. If Smart view has been launched
with the -serviceInfo option (see below), then it shows the internal
<param-value> for every parameter.)
Example 2:
Smartview.exe

-file:MySettings.HptPara

-paraKey:"/root/MDMs/I1/MultiSet/Fct/Char"

-paraValue:NINV

-paraSetnumber:?2

-checkParameter

-saveParameter
This example command starts Smart view and opens an existing
parameter file MySettings.HptPara, then it assigns a new value
NINV of a particular Setting Group Parameter within the specified

parameter set. Then it checks all settings for plausibility and finally
saves the parameter file.

<txt-filename> must be an existing text file that specifies parameter
setting values.

Smart view reads these settings and writes them into the currently
loaded parameter file.

The text file must contain one setting per line, and each line must
have the following format:

<param-key> <param-value> <parameter-set>

The specifications within each line must be separated one from
another by a blank character. For example:

/root/MDMs/CT 1 1/SingleSet/Current/CTprim 1234 0
/root/MDMs/I1/MultiSet/Fct/Char NINV 2

In addition, comment lines are allowed: Every line that starts with
either “#”, “;” or “//” is ignored.
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Option

-password: <password>

-connectionPassword:
<password>

-quit

-rasConnection

-rasConnection:
<network-connection>

SMARTV-5.50-EN-MAN

4 Command-Line Parameters and Exit Codes

Description

Command-Line Example:
Smartview.exe
-file:MySettings.HptPara
-paralListFile: "MyParameterValues.txt"
-checkParameter
-saveParameter
This example command starts Smart view and opens an existing
parameter file MySettings.HptPara, then it reads the settings from

the file MyParameterValues.txt. Then it checks all settings for
plausibility and finally saves the parameter file.

<password> is a valid access level password for the connected
device.

This password is necessary to change settings on the device.
For devices which support different access levels with different

passwords, always the password of the highest required access level
must be given.

<password> is the connection password for the protection device.
Depending on how the protection device is connected this is either
the “USB connection” password or the “Remote network connection”
password.

A password for establishing a Smart view connection is supported by
HighPROTEC devices as of Version 3.6.

(See »Chapter 6.9.)

This option makes Smart view exit immediately after it has finished
all its tasks.

Example:

Smartview.exe
-newFile:MySettings.HptPara
-deviceModel:MRA4 V3.4.a.dm c
-quit

This example command starts Smart view and makes it create a new
parameter file MySettings.HptPara, then exits.

Specify that the communication with the device shall be done with a
(e. g. serial PPP) network connection.

If an optional <network-connection> is available, then this
connection is used for the communication.

Smart view
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Option

-Ht13PIConnection:

<COM-Port>

-receiveParameter

-saveParameter

-saveParameter:
<filename>

-sendParameter

-sendParameter:
modified

34

Description

Example:

Smartview -rasConnection:”HighPROTEC Direct Connection”

Specify that the communication shall be done with a with a device
from the High Tech Line 3, the Professional Line or the WI Line series.

<COM-Port> is the number of the serial COM port to which the device
is connected.

Example:

Smartview -Htl3PIConnection:1

This option makes Smart view connect to a device and receive all
parameters from it.

Example:
Smartview
-receiveParameter
-saveParameter:MySettings.HptPara
-quit
This example command starts Smart view and makes it receive all

parameters from the connected device, then saves these to the
parameter file MySettings.HptPara, finally exits.

The currently loaded parameter data is saved with the current
filename.

If a <filename> has been specified then the parameter data is saved
to the specified file.

All the currently loaded parameter data are transferred to the
connected device, or - if in case of “modified” - only the modified
parameters are transferred.
Example 1:
Smartview.exe

-file:MySettings.HptPara

-sendParameter

-password:1234

-silent

-quit
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Option

-servicelnfo

-silent

-TcpIp

-Tcplp: <TCP/IP-
address>

-typecode: <typecode>

SMARTV-5.50-EN-MAN
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Description
This example command starts Smart view and opens the parameter
file MySettings.HptPara, then all parameters contained in this file
are transferred to the connected device. Finally Smart view exits.
Example 2:
Smartview.exe

-file:MySettings.HptPara

-paraListFile: "MyParameterValues.txt"

-checkParameter

-sendParameter:modified

-password:1234

-quit
This example command starts Smart view and opens an existing
parameter file MySettings.HptPara, then it reads the settings from
the file MyParameterValues. txt. Then it checks all settings for

plausibility, it transfers the modified parameters to the connected
device. Finally Smart view exits.

This option makes Smart view additional service information. In
general, this kind of information is needed only for service and
testing purposes

This option makes Smart view avoid user interactions while executing
some its tasks. This can be helpful if particular operations shall be
executed via command-line.

Specify that the communication with the device shall be done with a
TCP/IP connection

If an optional <TCP/IP-address> is available, then this address is used
for the communication

Example:

Smartview -TcpIp:192.168.0.8

<typecode> is a valid typecode string for the currently loaded
parameter data.

Example:

Smartview
-newFile:MySettings.HptPara
-deviceModel:MRA4 V3.4.a.dm c
-typecode:MRA4-2A0AAA

-saveParameter
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Option

Exit Codes

Description
-quit

This example command starts Smart view, it creates a new
parameter file from the existing device model based on the specified
typecode values. Then it saves this parameter modification in the
parameter file, and Smart view finally exits.

After one has called Smart view via command-line options it can be interesting to check the
exit code (also called return code).

The exit code gives information about whether the Smart view execution has been
successful or some error has occurred.

Exit Code
0
1

W

0 N O U

10
11
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Description

Smart view has successfully exited. No error.

File already exists.

Error in device template file.

Implausible parameter file.

Unknown error.

Error during writing parameter file.

No parameter data available.

Error during sending parameter data to a connected device.

Single parameter value could not be written with specific command-
line option.

Cannot read device template file.
Cannot read text file with list of parameter values.

Invalid typecode.
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5 Smart view Keyboard Commands

You can control Smart view alternatively by means of keyboard commands (instead of

the mouse)
Key
T
{

-
-

Numpad +
Numpad —
POS1
ENDE
STRG+O

STRG+N
STRG+S

F1

F2

F5

STRG+F5
STRG+Umschalt+T
Home

Page 1

Page {
Ctrl+Shift+Alt+S

SMARTV-5.50-EN-MAN

Description

Moving up within the navigation tree or parameter list.
Moving down within the navigation tree or parameter list.
Collapse the tree item or select a folder on a higher level.
Expands the tree item or selects a subfolder.

Expands the tree item.

Collapses the tree item.

Moves to the top of the active window.

Moves to the bottom of the active window.

Opens the file opening dialog. Browsing through the file system for an

existing device file.

Creates a new parameter file file by means of a template.
Saves actual loaded parameter file.

Displays the Smart view help information.

Load Device Data

Reloads the displayed data of a device.

Enables automatic refresh.

Back to the navigation window.

Walks through the tabular forms (detail windows).
Previous value (parameter setting).

Next value (parameter setting).

Switches on/off the service info mode, which displays additional
service information.

Smart view
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6.1 Loading of Device Data when using Smart view

6 Operating a HighPROTEC Protection Device
6.1 Loading of Device Data when using Smart view

0]

1. > Start Smart view.

2. > Make sure the connection has been established properly. (See =3 Setting up the
Connection between PC and Device.)

3. > Connect your PC with the device.

4. > Select »Receive Data from Device« in menu [Devicel.

A SYSTEM
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Shortcuts [ Device Data
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@® Protection Para
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— & Logics
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Device Para
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Field Para
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=
Protection Para
d

HPT_ZB9

5.

Fig. 8: After you have selected “Receive Data from Device”, Smart view presents the full menu
tree of the connected device.
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6.2 Transfer Device Data from Smart view to the Device

6.2 Transfer Device Data from Smart view to the Device

Via the button »Transfer only modified parameters into the device« only modified
parameters are transmitted into the device.

Parameter modifications are indicated by a red asterisk (“*” symbol) in front of the
parameter.

The asterisk (in the device tree window) indicates that parameters in the opened file
(within Smart view) differ from parameters stored on your local hard disk.

Via the button »Transfer only modified parameters into the device«, you can transmit all
parameters that are marked by this symbol.

If a parameter file is saved on your local hard drive, these parameters are no longer
classified to be modified and cannot be transmitted via the button »Transfer only
modified parameters into the devicex.

In case that you have loaded and modified a parameter file from the device and saved it
to your local hard drive without transferring the parameters into the device beforehand,
you cannot use the button »Transfer only modified parameters into the device«. In a case
like that, use »Transfer all parameters into the device«.

NOTICE!

The button »Transfer only modified parameters into the device« only works if modified
parameters are available in the Smart view.

In contrast to that, all parameters of the device are transferred when the
button »Transfer all parameters into the device« is pressed (unless there are invalid or
implausible device parameters, see <“Change a Parameter via Smart view - Example”).

1. > In order to (re-)transfer parameters into the device, please select either »Transfer all
parameters into the device« or »Transfer only modified parameters into the device« in
menu [Devicel.

Confirm the safety inquiry »Shall the parameters be overwritten into the device?«.
Enter the password for setting parameters in the popup window.

Thereafter the changed data is transferred to the device and adopted.

v v .V V

A confirmation dialog opens, asking you whether you want to save the changes into
a file. In general, this is recommended. Select a suitable folder on your hard disk and
click »Save«.

p The changed parameter data is now saved in the folder chosen by you.
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6.2 Transfer Device Data from Smart view to the Device

Error Message: Invalid Device Type

NOTICE!

In order to be able to transmit a parameter file into the device the following data must be
equal:

e Typecode (written as “CAT No.” on the top of the device/type label) and
¢ Version of the device model (can be found at [Device Para / Version] »DM-Version«.

In case of a non-matching device type the error message “Invalid Device Type” is issued.

40 Smart view SMARTV-5.50-EN-MAN



6 Operating a HighPROTEC Protection Device
6.3 Backup and Documentation when using Smart view

6.3 Backup and Documentation when using Smart view

How to Save Device Data on a PC

0

1. > Click on »Save as ...« in menu [File].
2. > Specify a name and choose a folder on your hard disk.

3. > Save the device data accordingly.

Printing of Device Data when using Smart view (Setting List)
The »Printing menu« offers the following options:

¢ Printer setting

* Page preview

* Printing

e Export the selected printing range into a txt-file.

The printing menu of the Smart view software offers contextual different types of
printing ranges.

* Printing of the complete parameter tree:All values and parameters of the present
parameter file are printed.

e Printing of the displayed working window:

Only the data shown on the relevant working window are printed, i. e. this applies, if
at least one window is opened.

* Printing of all opened working windows:

The data shown on all windows are printed, i. e. this applies only if more than one
window is opened.

* Printing of the device parameter tree as from a shown position on:
All data and parameters of the device parameter tree are printed as from the

position/marking in the navigation window. Below this selection the complete name
of the marking is additionally displayed.

Saving Data as a txt-file via Smart view

Within the print menu [File / Print] you can choose »Export into File« in order to export the
device data into a text-file.
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6.3 Backup and Documentation when using Smart view

' Only the actual selected printing range will be exported into a text-file. That means:
[

If you have chosen the “Complete device parameter tree” then the “Complete device
parameter tree” will be exported. But, if you have chosen “Actual working window”, only
this window will be exported.

You can print out operating data but not export them.

If you export a txt-file, the content of this file is encoded as Unicode (UTF-8). Therefore the
application that you want to use to open the file must support this encoding. (This, however,
should be the case with all modern PC applications.)
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6 Operating a HighPROTEC Protection Device

6.4 Offline Device Planning via Smart view

6.4 Offline Device Planning via Smart view
NOTICE!
In order to be able to transmit a parameter file (e. g. offline created) into the device the
following data must be equal:
o * Typecode (written as “CAT No.” on the top of the device/type label) and
* Version of the device model (can be found at [Device Para / Version] »DM-Version«.

The Smart view software enables also to parameterize offline. The advantage is: By using
device models you can do planning jobs for a device and set parameters in advance.

You can also read the parameter file out of the device, further process it offline (e.g. from
your office) and finally re-transfer it to the device.

You can either:

¢ load an existing parameter file from a device (see <6.1 Loading of Device Data when
using Smart view).

e create a new parameter file (see below),
* open a locally saved parameter file (backup).

In order to create a new device/parameter file by way of a device template offline:

1. > In order to create a new offline parameter file please choose within the menu [File] the
entry »Create new parameter file«.

2. > A dialog window pops up. Please make sure that you select the right device type with
the correct version and configuration.

3. > Finally click on »Apply«.

\%

In order to save the device configuration select »Save« out of the [File] menu.

5. > Within the menu [Edit / Modify Device Configuration (Typecode)] you can modify the
device configuration or simply find out the type code of your current selection.

For the transfer of the parameter file into a device, see 6.2 Transfer Device Data from
Smart view to the Device.
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6.5 Measuring Values

6.5

>

Measuring Values

Read out of Measured Values via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double click on icon »Operation« in the navigation tree.
Double click on icon »Measured Values« within the navigation tree [Operation].

Within the »Measured Values«, double click the category of measured values that you
are interested in.

The measured and calculated values are shown now in tabular form.

To have the measuring data read in a cyclic manner, select »Auto refresh« in menu
[View]. The measured values are read out about every two seconds.

The »Auto refresh« feature, however, always only keeps the [Operation] menu branch of
the device (i. e. measured values, states, etc.) updated. It is not for retrieving settings
(that might have been changed directly at the panel). The settings are only retrieved
(again) by pressing the key »F2« at the PC (or Smart view menu item “Receive Data from
Device”), see =6.1 Loading of Device Data when using Smart view.

44

Smart view SMARTV-5.50-EN-MAN




6.6

B
\Y

= e e
v V.V VvV V V

v

v

6 Operating a HighPROTEC Protection Device

6.6 Acknowledgments and Resets

Acknowledgments and Resets

Manual Acknowledgment via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double click on icon »Operation« in the navigation tree.

Double click on icon »Acknowledgement« within the operation menu.
Double click the entry within the popup that is to be acknowledged.
Press the button »Execute immediately«.

Confirm the question if the changes should be executed by »Yes«.

Enter your password.

External Acknowledge via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Devicel].

Double click on icon »Device Para« in the navigation tree.
Double click on icon »Ex Acknowledge« within the operation menu.

In the dialog window, you can assign now each one signal that resets all
acknowledgeable LEDs, a signal that resets all binary outputs, a signal that resets the
SCADA-signals respectively a signal that acknowledges a pending trip command.

Manual Resets via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Devicel].

Double click the »Operation« icon in the navigation tree.
Double click the icon »Reset« within the menu [Operation].

Double click the entry within the popup that is to be reset or deleted.
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6.7 Status Display via Smart view

1. > In case Smart view is not running - please start it.

2. > If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

3. > Double click the »Operation« icon in the navigation tree.

Double click the icon »Status Display« within the menu [Operation].

Y%

5. > Double-click on any of the subordinated modules. If, for example, you want to see the
states of general alarms, double-click on the entry »Prot«.

NOTICE!

' To have the data read in a cyclic manner, select »Auto refresh« in menu [View]. The
®

measured values are read out about every two seconds.

Signal State / Module Input Display within Smart view
false / »0« 0
true / »1« 1
No connection to the device or busy. ?
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6.8 Recorders

Recorders

Disturbance Recorder
Disturbance records / DataVisualizer

With the tool DataVisualizer it is possible to visualize the disturbance records of the device.
The DataVisualizer is always installed along with Smart view.

e Disturbance records can be downloaded (read out) by means of the parameter
setting and evaluation software Smart view.

e The disturbance records can be viewed and analyzed within DataVisualizer.

» Disturbance records can be converted into the COMTRADE file format by means of
DataVisualizer.

A disturbance record contains measuring values inclusively some (configured) pre-trigger-
time. By means of Smart view |/ DataVisualizer the oscillographic curves of the analog
(current, voltage) and digital channels/traces can be shown and evaluated in a graphical
form. The disturbance recorder has a storage capacity of 120 s. The disturbance recorder is
able to record up to 15 s (adjustable) per record. The amount of records depends on the size
of each record.

Check Disturbance Records via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double click the »Operation« icon in the navigation tree.

Navigate to the menu branch [Operation / Recorders] and double-click on »Disturb rec«.
In the window the disturbance records are shown in tabular form.

Double-click any disturbance record and choose a folder where it is to be saved to.

You can analyze the disturbance records using the software DataVisualizer after clicking
on »Yes« when you are asked “Shall the received disturbance record be opened by the
DataVisualizer?”

Delete Disturbance Records via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double click the »Operation« icon in the navigation tree.
Navigate to the menu branch [Operation / Recorders] and double-click on »Disturb rec.

In the window the disturbance records are shown in tabular form.
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In order to delete a disturbance record double-click on: »X« (the red x) in front of the
disturbance record and confirm.

Fault Recorder

Check Fault Records via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double click the »Operation« icon in the navigation tree.
Navigate to the menu branch [Operation / Recorders] and double-click on »Fault rec«.
In the window the fault records are shown in tabular form.

In order to see more detailed information on a fault, double-click the item in the list.

Via the print menu you can export the data into a file. Please proceed as follows:

Open the data as described above.
Press the button »Print«.

Press the button »Export to File«.

Enter a file name.

Choose a location where to save the file.

Press the button »Savex.

Trend Recorder
Trend Recorder

The Trend Data are data points stored by the Trend Recorder on the relay device over fixed
intervals of time, and can be downloaded from the device using Smart view. A Trend Record
is viewable using the Data Visualizer software by selecting files saved by Smart view with a
file extension of “. HptTr”.

The list of available trend recorder data is viewable by selecting [Operation / Recorders /
Trend rec].

When viewed within the DataVisualizer, the trend record will show the observed values (up

to 10) that the user has specified. The values available in the Trend Recorder depend on the
type of the connected device and the configuration of the Trend Recorder.
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Managing Trend Records

To download information from the Trend Recorder, select [Operation / Recorders / Trend rec]
from the menu tree. The user will find three options within the Trend Recorder window that
will allow to:

¢ Receive Trend Records,
¢ Refresh the Trend Recorder, and
¢ Delete Trend Records.

Selecting the »Receive Trend Record« button will download data from the relay to the user's
PC. By selecting the »Refresh Trend Recorder«, Smart view updates the list of Trend Records.
The »Delete Trend Records« button removes all trend data from the relay. Trend Recorder
data previously stored on the user's PC remains untouched.

After having received trend data from the device, the user can view the data in the
DataVisualizer by double-clicking on the received “.HptTr” file stored on the PC. Once the
“.HptTr” file is open, the user will see the “Analog Channels” that are monitored by the
Trend Recorder. By clicking on the “Analog Channels”, all monitored parameters are listed.
To view a channel, the user must click on the left mouse key, then drag and drop the channel
onto the right-hand side of the DataVisualizer screen. The channel is then listed under
the »Displayed Channels«.

To remove a channel from view, the user must select the Trend Data to be removed in
the »Displayed Channels« menu tree, then click on the right mouse button to bring up
the menu options. Here, the user finds the »Remove« menu option that, when selected,
removes the trend data.

Event Recorder

Check Event Records via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double click the »Operation« icon in the navigation tree.
Navigate to the menu branch [Operation / Recorders] and double-click on »Event rec«.

In the window the event records are shown in tabular form.

NOTICE!

To have the event data read in a cyclic manner, select »Auto refresh« in menu [View].

Smart view is able to record more events than the device itself, if the window of the
event recorder is opened and »Automatic Up-Date« is set to active.

Via the print menu you can export the data into a file. Please proceed as follows:
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1. > Open the data as described above.

2. > Select the menu [File / Print].

3. > Choose »Print Actual Working Window« within the popup.
4. > Press the button »Print«.

5. > Press the »Export to File« button.

6. > Enter a file name.

7. > Choose a location where to save the file.

8. > Press the button »Save«.
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6.8.5 Motor Start Recorder
Motor Start Recorder
Manage Motor Start Records
The Motor Start Recorder logs information during a motor start-up. These records are
stored in a fail-safe manner and the capacity allows for recording up to 5 start-ups. After 5
start-ups, every following start-up overwrites the recording of the oldest one (“First in First
out” principle).
Every recording consists of a summary of information and recorded analog trends. However,
the exact set of data is dependent on the ordered device variant. The summary data can be
accessed using Smart view or via the front panel interface. This feature provides information
recorded at the time of each start of the motor such as:
¢ Date of the motor start event

¢ Record number

e IL1 max RMS, IL2 max RMS, IL3 max RMS, IG max RMS - Maximum RMS phase
current of the respective phase

e Unbalance max - Maximum current unbalance during the motor start-up

* | avg - Average current of all three phases at the time of the start-to-run transition
e Speed - The motor nominal speed (1 or 2)

* Time (duration) values:

o tS-tl - The time that elapses from the start until the current value drops below
the set start-up threshold

o tS-tR - The time that elapses from the start until the motor is running, or - in
case of an incomplete start sequence - until the trip command

* |2T used - Thermal capacity used, specified as percentage of the maximum thermal
capacity

» Start success - This is set to 1 if the motor start has been successful (and equals 0
otherwise).

Smart view allows for storing the summary information as text files, or have them
printed out.

The analog trends can be viewed using the DataVisualizer software. Examples for recorded
analog trends are:

* Phase current values
* Current unbalance
e Thermal capacity
* Temperatures (in case an RTD box is fitted)
Read Motor Start Records via Smart view:
The start recorder data can be downloaded by means of Smart view from the device.

» Start Smart view if this has not been done already.
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 If the data has not been downloaded from the device yet, select the menu item
“Receive Start Recorder” in the “Device” menu.

» Within the navigation tree, go to the [Operation / Recorders] menu. Here the user
will find the »Start rec« menu item.

e When »Start rec« is selected the Start Recorder Window appears.

To access data that has been stored in the device using Smart view, the user must select
the “Receive Start Recorder” button in the upper left hand corner of the “Start Rec” window.
When clicked, the Smart view software will retrieve the highlighted record from the device.

After selecting one of the max. 5 recordings a summary of the Start Recorder data can be
retrieved (for the selected recording) by clicking the “Receive Summary Data” button in the
upper left hand corner of the “Start Rec” window.

A list of all currently available Start Records is viewable by selecting the “Refresh Start
Recorder” button on the start recorder.

It is possible to delete individual records that are stored on the protective device. First, select
“Receive Start Recorder”, and then select the record to be deleted by clicking on the record
number, followed by the selection of the “Delete Start Record” button in the upper left hand
corner of the “Start Rec” window.

To permanently remove all start records within a device's start recorder, select the “Delete
All Start Records” button also located in the upper left hand corner of the “Start Rec”
window. This removes all previously stored start records within the device to which the user
is presently connected.

Open a Start Record file from a local storage device. Please note that it is possible to
compare an archived Start Record against archived Parameter settings that are also stored
on a local device. Read the “Caution” information below (page <K).

When using Smart view to view the Start Recorder data, the Start Recorder features can also
be found by right clicking anywhere within the “Start Rec” window.

' The “Print” button takes the user to the printing dialogue, where it is possible to export
®

the summary into a text file. This is done the following way:

* Retrieve the data in the “Start Rec” window, as described above.
* Click on the button “Receive Summary Data”.

e Click on the “Print” button.

* Click on the button “Export to file".

* Enter a valid file name.

¢ Select the file path.

* Click on the “Save” button.
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Display Start Records:

When a Start Record is called up, a window with the following options pops up.
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View motor start data graphically in the DataVisualizer software. In the
DataVisualizer software the user can view the RMS value of the phase currents,
thermal capacity used, and temperatures measured by the URTD module if a URTD
is installed and attached to the relay.

View motor start data overlayed with the Motor Protection Curves (Starting Profile
Plot versus Protection limits). The user can view the average current recorded

H during the motor start versus protection elements such as 50P, or the Thermal

Model. The user has the option to alter the displayed setting groups.

Please note: Protective elements that are not projected within the device planning
are not visible.

The Starting Profile Plot offers two user scenarios:

» Adapt the protection settings to the recorded start curve: The user then sees the
impact of parameter changes in the Profile Plot. By means of this the user can
decide if the relay settings match the protection requirements.

¢ Analyze a Start Record: Since a Start Record does not include the relay settings, the

user has to ensure that backups of the relay settings are available that were valid at
the time of recording.

CAUTION!

Please note that the Starting Profile Plot shows the recorded average current versus the
current relay settings. The relay settings itself are not part of a Start Record.

Adaptive parameters and their impacts wont be visible within the Starting Profile.
Blockings wont be visible within the Starting Profile.

Please make sure to save the setting files together with this record to guarantee the
graph represents the conditions of when this event occurred.
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6.8.6

6.8.7

Statistic Recorder

The Statistic Recorder shows motor specific statistical data on a monthly base. The Statistic
Recorder can record up to 24 monthly reports. The reports are power fail safe stored.

In order to view information from the Statistic Recorder, the user has to select [Operation /
Recorders / Statistic rec] from the menu tree.

When using Smart view, a double-click on the »Date of Record« shows detailed statistical
information such as the number of starts, the number of successful starts, the average start

time, the »average 12T« value during any start, and the average of all maximum currents
value seen during each start.

Internal Messages (Self-Supervision Recorder)

Check Self-Supervision Messages via Smart view

This feature is available only when connecting with a recent HighPROTEC protection
device (as of version 3.4).

54

The protection device supervises its own functionality by constantly performing various
self-tests. If it detects any serious problem, or any event that has a serious impact on the
operation of the device then this event is recorded.

HighPROTEC protection devices as of version 3.6 use this recorder also for security-related
messages, for example to report a problem with the encrypted communication or if a wrong
password has been entered.

The menu [Operation / Self-Supervision / Messages] gives access to this list of internal
messages. The following data is part of each entry:

* Record Number - a counter without special meaning

» Date of Record - timestamp of the event

e Message - a message ID with a (short, heavily abbreviated) message text
* Value - additional data specific to the event

All messages that can potentially appear here are described in detail in a separate
document, the “HighPROTEC Troubleshooting Guide” (HPT-5.50-EN-TSG).
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6.9 Passwords

In general, there are access level passwords, that permit to change the setting values of
related parameters, and connection passwords, that permit to establish a connection of the
Smart view with the operating software Smart view.

Note, however, that connection passwords are always prompted for by Smart view, i. e. they
are always entered via PC keyboard. (See the “Security” chapter of the Technical Manual of
your HighPROTEC device for a detailed description.)

Q Entering wrong passwords (regardless whether connection password or access level
password, and regardless whether via HMI or Smart view) triggers a “time penalty”
l stage: The Smart view blocks any further password entry for an increasing amount of
time, until a correct password has been entered. A dedicated message informs the user

about this blocking. This timer affects only the password entry (i. e. the Softkey m
on the HMI), so that it does not prevent the user from doing some other, “password-free”
activities during this blocking time.

Change Passwords via Smart view

Download the parameter file from the device.

1. > Passwords can be changed by a double-click within the menu [Device Para / Security /
Password] on the corresponding password.

2. > Enter the old password and the new password twice.

3. > Confirm the changes by a click on »OK«.
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6.10 Device planning

6.10.1 Projected Elements

“Device planning” means to change the functional range to a degree that suits the
protection task to be fulfilled (i. e.: the device deactivates all functions that are not needed,
and shows only the active ones).

There is a top-level menu item [Device planning / Projected Elements] that is dedicated to
this; it collects a setting parameter for each function which can be set to “-” or to “use”.
(In some cases there are additional setting options, for example with devices featuring
direction determination).

If the user, for example, activates the voltage protection function, all menu branches
related to this function appear in the menu tree. All corresponding events, signals, etc., are
activated as well.

It MUST be taken into account that Device Planning changes the functionality of the
device.

If, for example, the user cancels the directional feature of the overcurrent protections,
the device will no longer trip in a directional way but merely in a non-directional way. If
the user deactivates a protection function, the device will no longer trip according to the
criteria related to this protection function.

The manufacturer does not accept liability for any personal or material damage as a
result of incorrect planning.

Contact your SEG Customer Service representative for more information.

Beware of the inadvertent deactivating of protective functions/modules, because all the
settings of a deativated module get lost (i. e. are set back to their respective default
values)!

This means: If the user is activating any of these modules again at some later time, all
parameters of the re-activated modules need to be reconfigured.

6.10.2 Definition
It is possible for most protection stages to define during the commissioning setup whether
this stage shall issue a trip signal in case of a fault, so that the circuit breaker gets opened,
or whether the stage shall simply issue an alarm signal, without tripping. This setting can be
done within the menu [Device planning / Definition].

For more details please see {? GeneralAlarms_GeneralTrips}.
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6.11 Parameters

Parameters
Parameter Setting via Smart view

Smart view shows within the windows, where parameters are edited also the required
access level for the parameters and settings. The required access authorizations will be
verified when the parameter file should be transferred into the protective device. For the
transmission, two options are available.

* The transfer of all Parameters. This always requires the Supervisor (administrator)
password.

¢ The transfer of the modified Parameters only. Smart view checks the set of access
levels that are required by the parameter to be modified, and it prompts for the
highest required passwords (access authorizations).

Example 1:

A »Prot-Lv1l« parameter and a »Prot-Lv2« parameter have been edited and are about to
be transferred. The user is being prompted for the password »Prot-Lv2«.

Example 2:

A »Prot-Lv1l« parameter, a »Prot-Lv2« parameter and a device planning parameter have
been edited and are about to be transferred. The user is being prompted for the
administrator password »Supervisor-Lv3«.

Example 3:

A »Prot-Lv1l« parameter, a »Prot-Lv2« parameter and a »Control-Lvl« parameter have
been edited and are about to be transferred. The user is being prompted for the two
passwords »Prot-Lv2« and »Control-Lv1«.

Change a Parameter via Smart view - Example

Example: Changing of a protective parameter. (We want to alter the characteristic for the
overcurrent protection function »I[1]« in parameter set 1).

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double-click the icon »Protection Para« in the navigation tree.
Within the [Protection Paral menu, double-click the icon »Set 1«.
Within the parameter set 1, double-click »I-Prot«.

Double-click »I«[1].

In the dialog window a tabulated overview appears, showing the parameters assigned to
this protective function.

In this table double-click the value/parameter you want to change (here: »Char«).

An editing dialog window is opened where you can select the required characteristic.
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Close this window by clicking the »OK« button.
Additional parameters can be changed if required. (See also -»“Plausibility check”.)

There are two options available within the menu [device]: Transfer all parameters to the
device, or only the modified ones. See -6.2 Transfer Device Data from Smart view to the
Device.

In the confirmation dialog, accept that the parameters be overwritten.
Enter all the passwords that you are prompted for.
Afterwards the parameters are transferred to the protection device.

Another confirmation dialog opens, asking you whether you want to save the changes
into a file. In general, this is recommended. Select a suitable folder on your hard disk
and click »Save«.

The changed parameter data is now saved in the folder chosen by you.

NOTICE!

An asterisk (“*” symbol) in front of the changed parameters indicates that the alterations
have not yet been stored in a parameter file. This is independent of whether the
parameters have been transferred to the device in the meantime.

In order to make things easier to follow, especially where complex parameter changes
are involved, the menu tree indicates the parameter change by the asterisk on every
superior/higher menu level, too (“star trace”). This makes it possible to control or follow
up from the main menu level at any time where parameter changes have been made but
not been saved yet.

The “star trace” is cleared only if the parameter changes are saved in a parameter file,
or if all device data is reloaded from the device.

NOTICE!

Once you have entered a password, Smart view remembers it for ca. 10 minutes so
that you are not asked again during this time. This time interval is re-started whenever
parameters are transmitted into the device. If no parameters are transmitted into the
device for a duration of more than 10 minutes, Smart view clears its password memory
so that you are asked again when you are trying to transmit parameters into the device.
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Plausibility check

NOTICE!

Sometimes there are dependencies between parameters. This means that changing a
setting can make another parameter valid.

In order to prevent wrong settings Smart view constantly monitors all temporary saved
parameter changes. If it detects an implausibility, this is indicated by a red question
mark in front of the respective parameter.

In order to make things easier to follow up, especially where complex parameter
changes are involved, on every superior/higher menu level above of the temporary saved
parameters, an implausibility is indicated by a question mark (plausibility trace). This
makes it possible to control or follow from the main menu level at any time where
implausibilities exist.

So it is possible to see from each point of the menu tree that implausibilities have been
detected by the software.

An asterisk/parameter change indication is always overwritten by the question mark/
implausibility symbol.

If the software detects an implausibility it rejects saving and adopting of the parameters.
The user is expected to resolve all implausibilities by double-clicking each invalid

parameter. This editing dialog presents only the valid setting(s), and the user has to
explicitly accept by clicking »OK«.

Y

Switch Setting Groups (Parameter Sets) via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double-click the icon »Protection Para« in the navigation tree.
Within the [Protection Paral menu, double-click the icon »PSet-Switch«.

Configure the Setting Group Switch respectively choose an active set manually.

Copying Setting Groups (Parameter Sets) via Smart view

NOTICE!

Setting groups can only be copied if there are no implausibilities (no red question mark,
see the Notice at the end of »“Change a Parameter via Smart view - Example”).

It is not necessary to set up two setting groups that only differ in a few parameters.

With the help of Smart view you can copy simply an existing setting group to another
one(not yet configured) . You only need to change those parameters where the two setting
groups are different.
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To establish efficiently a second parameter set where only a few parameters are different,

proceed as follows:

In case Smart view is not running - please start it.

Open an (offline) parameter file of a device or load data of a connected device.
By way of precaution, save (the relevant) device parameters: [File / Save as]
Select »Copy Parameter Sets« out of the menu [Edit].

Define the source and destination parameter set for copying (source = »copy fromx;
destination: »copy to«).

Click on »OK« to start copy procedure.
The copied parameter set is cached now, but not yet saved.
Then modify the copied parameter set(s) as required.

Assign a new file name to the revised device parameter file and save it on your hard
disk (backup copy).

Transfer the modified parameters back to the device (see <6.2 Transfer Device Data
from Smart view to the Device.)

Compare Setting Groups via Smart view

In case Smart view is not running - please start it.
Open an (offline) parameter file of a device or load data of a connected device.

Click on menu item [Edit] and select »Compare Parameter Sets«.

Select the two parameter sets from the (two) drop down menus you would like to have

compared with each other.
Press the button »Compare«.

The values that are different from the set parameters are listed in tabular form.

Parameter Files

Parameter files have the extension *.HptPara and store all settings of a protection device.

An HptPara file is always related to a device model (see the HighPROTEC Quick Start Guide,

HPT-5.50-EN-QSG or the device documentation).

Therefore you have two alternative principles for the creation of a new configuration file:

* Creating a *.HptPara offline, i. e. without being connected to a protection device.
In this case Smart view opens selection dialogs, asking you to specify the exact
device and typecode for which the configuration shall be made. (The “typecode”,

also called “order code”, defines the particular device variant, including housing and

communication options.)

In the typecode dialog, it is possible to double-click every specification line (or

highlight it and click the »Edit« button) and adapt the entry to your particular device.
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Alternatively, you can also click the “pencil” button and directly type in the letters
and digits of your device's typecode.

You can find the typecode printed as “CAT No.” on the adhesive label that is glued to
the housing of the protection device.

And finally, you can use the Smart view menu »[File - Properties]« to open a window
that displays various information, including the typecode.

* Creating a *.HptPara while being connected to a particular device. In this case
Smart view defines all settings for this particular device, and immediately after
having retrieved the data from the device Smart view asks you whether you want
to save them into a new HptPara file. (Of course it is possible to re-use the HptPara
file later for another protection device, provided the variant and firmware version
(release) are identical.)

With an established connection (and as of HighPROTEC Version 3.4,), you can also
check the value of [Device Para / Version] »CAT No.«.

And finally, you can use the Smart view menu »[File - Properties]« to open a window
that displays various information, including the typecode.

Open a Parameter File
The menu item [File / Open Existing Parameter File] opens an existing parameter setting

file. If another parameter file is already open, this file and all related open dialog windows is
automatically closed.

Save a Parameter File

The menu item [File / Save] saves the currently opened parameter setting file.

Save a Parameter File as a New File

The menu item [File / Save As] saves the currently opened parameter setting file at a
different location or with a different filename.

View Properties of a Parameter File

The menu item [File / Properties] shows the properties of the currently opened parameters/
menu tree in a new window.

This is, for example:

the filename (if loaded from file)

e the origin of the parameter data (loaded from file or received from device)

version information (device type, typecode, version)

various internal locations and paths (e. g. folder and filename of the used device
model)

Compare Parameter Files via Smart view

With the help of Smart view you can simply compare/diff the currently open parameter/
device file against a file on your hard disk. The precondition is that the versions and type of
devices match. Please proceed as follows:
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0

1. > Click on »Compare with a Parameter File« within the menu [Device].

2. > Click on the folder icon in order to select a file on your hard disk.
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The differences are shown in tabular form.

Converting Parameter Files via Smart view

Parameter files of the same type can be converted. As many parameters as possible will be
taken over.

* Parameters that are added are set to the default value.
* Parameters that are not part of the target file version are deleted.

In order to convert a parameter file please proceed as follows:

In case Smart view is not running - please start it.

Open a parameter file or load the parameters from a device that should be converted.
Make a backup of this file at a fail safe place.

Choose »Save as« from the menu [File].

Enter a new file name (in order to prevent overwriting the original file)

Choose the new file type from the drop-down menu »File Type«.

Confirm the security check by clicking on »yes« if and only you are sure that the file
conversion should be executed.

In the tabular form the new and deleted parameters are shown as follows.
New parameter: -+
e

Deleted parameter: X/Q

Close a Parameter File

The menu item [File / Close] closes the currently opened parameter setting file and all
related open dialog windows. If the parameter setting file has been modified or an unnamed
file has not been saved yet, Smart view reminds you to save this parameter setting file.
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6.12 Digital Inputs

Assignment of Digital Inputs

Option Option

® O,

Assignment of the Input Signal

S - Protection Module 1

[Device Para/digital input]

D -

Assignment of the Input Signal

~— - Protection Module 2

There are two options available in order to determine where a Digital Input should be
assigned to.

E_F84

Option 1: Assigning a Digital Input onto one or multiple modules.
Adding an assignment via Smart view:

Within menu [Device Para / Digital Inputs], Digital Inputs can be assigned onto one or
multiple targets.

Select the Digital Input (double-click on the DI entry) and select the assignment that has to
be added.

By means of clicking on »Add« the assignment is shifted from the list of available to the list
of used assignments.

Deleting an assignment via Smart view:

Select the assignments (double-click on the DI entry) and select the assignment that is

to be deleted. The assignment is deleted from the list of used assignments by means of
clicking on »Removex.

Option 2: Connecting a Module Input with a Digital Input

Navigate to a module. Within this module assign a Digital Input onto a module input.
Example: A protection module should be blocked depending on the state of a Digital Input.

For this enter the [Global Prot Para] and assign the required Digital Input to the blocking
input (e.g. »ExBlol«) .

Check the Assignments of a Digital Input

In order to check the targets that a Digital Input is assigned to please proceed as follows:
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6.12 Digital Inputs

1. > Enter the menu [Device Para / Digital Inputs].

Navigate to the Digital Input that you want to check.

Y%

3. > All targets of a Digital Input will be shown, listed and separated by a semicolon behind a
Digital Input.
Please note that the window might be to small and thus hide some targets.

4. > All assignments can be seen by means of a double click onto a Digital Input. Within this
window also further assignments can be done.
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6.13 Synchronize Date and Time via Smart view

Synchronize Date and Time via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Within the navigation tree, enter »Date and Time«, which is in the menu branch [Device
Para / Time]. Double-click this entry.

A dialog opens that shows the current date and time of both PC and HighPROTEC device.
(A checkbox allows to toggle the timezone between local and UTC; however, see also
the note below.)

Click on the button »Synchronize«. You are then asked for the password of access
level »Supervisor-Lv3«.

The HighPROTEC device receives and takes over date and time from the PC.

NOTICE!

Smart view as of version 4.50 in connection with a HighPROTEC device as of version 3.4
is able to consider that the timezone settings might be different on PC and HighPROTEC
device.

This is not possible in case of a connection with an older HighPROTEC device, so that
there is the risk of ending up with a wrong time setting. Therefore it is recommended in
case of an older HighPROTEC device to first set the device to the same timezone as the
PC and only afterwards synchronize date and time.

If you are unsure whether your connection supports this timezone check: If the checkbox
for toggling between UTC and local timezone is visible in the dialog mentioned above
then the timezone check is supported.
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6.14 Display Version Information

Within the menu [File / Properties] you can obtain detailed information on the currently
opened file like e. g. software and hardware version.

In order to be able to transmit a parameter file (e. g. offline created) into the device the
following data must be equal:

o * Typecode (written as “CAT No.” on the top of the device/type label) and
¢ Version of the device model (can be found at [Device Para / Version] »DM-Version«.
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6.15 Display of ANSI-Codes

It is possible to make Smart view display ANSI codes:

0

1. > In case Smart view is not running - please start it.

2. > Within the menu [Settings], tick the checkbox »Display ANSI device numbers«.
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6.16 Graphical Display of Tripping Characteristics

Smart view supports the graphical display of tripping characteristics. Depending on the
device type and the device configuration various tripping characteristics and related
characteristics can be displayed.

* Overcurrent Tripping Characteristics (ANSI, IEC,...)

* LVRT/FRT Profiles (Low Voltage Ride Through)

e Tripping areas of the underexcitation protection

* Switchgear-Wear-Curves
Example - Graphical Visualization of the Overcurrent Tripping
Characteristic »I[1]«

1. > If the device data/parameters are not loaded yet, please load them from the device or
open a file.

2. > Within the navigation tree, enter the menu branch [Protection Para / Set 1 / I-Prot / I[1]].
3. > Double-click on the protective element »I[1]«.

4. > A dialog window is opened that shows all the parameters in tabular form that are tied to
this protective element.and that define the tripping characteristic.

5. > C
Click on the icon »View Characteristic« within the toolbar of this window: 1"""

6. > A new window now shows the graphical visualization of the selected tripping
characteristic.

Adding and Removing Tripping Characteristics to the Visualization

Additional tripping characteristics of further protective elements and protection sets can be
added to the visualization.

Example: Adding Additional Curves to the Visualization of the Tripping
Characteristic »I[1]«

1. > Open, as described in the example above, the window for the visualization of the
tripping characteristic of the protective element »1[1]«.

2. > Click within the toolbar of this diagram window on the icon »Add/Remove Curves...«:
(s

3. > A selection window pops up. There you can select:

* Which protective elements should be displayed additionally. (Only available, if more
than one protective element of the same type is projected.)

* Which parameter sets should be shown additionally in this visualization. (Only
available, if this protective element is available in multiple parameter sets.)
4. > Select those curves, that you want to add to the current visualization.
5. > Close the selection window by a click on »Apply«.

p The graphical visualization is updated, so that the additionally selected curves are
shown.
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Selection of related curves

Related curves (e. g. reset curves, voltage restrained overcurrent curves, ...) can be
displayed, the availability is depending on the device and configuration.

If such curves are available they can be selected by a drop-down menu in the toolbar of the
diagram window.

& Example: Visualization of the Reset Curve for Overcurrent Element »I[1]«

1. > Open as described in the example above, the working window for the visualization of the
tripping characteristic of the overcurrent element »1[1]«.

2. > There is a drop-down menu within the the upper menu bar of this working window. This
can be used in order to select related curves as:

* Tripping characteristics
* Reset curves
* Voltage restrained overcurrent protection curves

3. > Select within the drop down menu »Reset curve«

» The diagram window gets updated. Now the »Reset Curve« is shown instead of
the »Tripping Curvex.
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6.17

Single-Line Diagrams

The single-line diagram is displayed after the »CTRL« has been pressed on the HMI of a
HighPROTEC device. It can be replaced by another one, so that you are able to adapt it to
your application. The following is important to know in this context:

O

11

When Smart view saves the current configuration to a “*.HptPara”-file the currently
active single-line diagram is always included. Vice versa, if you load an HptPara file
and transfer it to the protection device the single line diagram contained therein gets
displayed.

But it is important to note that the other way round is not possible: There is no way

to retrieve the currently active single-line diagram (in editable form) from the protection
device, nor is it possible to export it from the HptPara file. As a consequence, it is
strongly recommended to archive all the files that you have come across, not only the
original file from which you started, but also all files that you created as individually
modified single-line diagrams. There is a dedicated “*.HptPage” file format that keeps a
single-line diagram - the so-called “page” - for later re-use.

70

Remark: The default single-line that the protection device displays after a factory reset
can be found as an HptPage file on the product CD that has been part of the delivery.
Alternatively, it can be downloaded from the web-address that is printed as a QR-code on a
sticker fastened on the device. In most cases you can use it as a template and adapt it to
your individual needs.

The software to be used for editing an HptPage file is named Page Editor. It is a stand-alone
application which is installed along with the Smart view installation. It is possible to launch
it the usual way, (for example) via the Windows Start button. But if you have Smart view

already running it is probably more convenient to use the menu item [Tools — Page Editor].

Please refer to the Page Editor Manual for a description of what can be done within the Page
Editor. The Page Editor Manual can be simply opened by calling the Page Editor menu item
[Help - Help] (or pressing the »Fl« key).

After you have saved your own HptPage file you transfer it to the protection device
as follows:

In Smart view, open the menu item [Device planning / Projected Elements].

A double-click on the entry »Ctrl . Single Line«, “@" in the diagram below, opens the
editing dialog.

The following information is displayed along with the preview of the single-line diagram:

* Single-line Name — The name of the currently used Single-line, e. g.
“BusbarFeeder”
e Switchgear Properties — a list with the switchgears that are used in the single-line.

For each switchgear, a running number is shown (e.g. “SG 1”), the short
designation (as it appears in the single-line, e. g. “QA1”) and the switchgear type
(e.g. “Controlled Make Break SG").

* »Single-line Diagram« — Clicking this button allows for replacing the single-line by
some other, which is stored in an HptPage.

3. > Click on the button »Single-line Diagram« (“@” in the diagram below).

» This opens a file-select dialog.
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Select your HptPage file.

The editing dialog displays the selected file (filename without “HptPage” extension, plus
preview. If you have successfully passed the “Compatibility Check” of the Page Editor
your new single-line should be o.k. so that the field »Single-line Error Messages« is
blank.

Click »Apply« to close the editing dialog (“®” in the diagram below).

The parameter »Ctrl . Single Line« is now marked as “modified” (see =“Change a
Parameter via Smart view - Example” and, in particular, the Notice about the “red
asterisk” token therein).

Just as with any parameter change, the final step is to transfer the modifcations to

the protection device (keys »F7« or »Ctrl«+»F7«, or menu items [Device —» Transfer ALL
Parameters into the Device], [Device - Transfer only modified Parameters into the
Device], see -6.2 Transfer Device Data from Smart view to the Device).

@]] Device planning '

Module . name Value '

.

ég Ctrl . Single Line BusbarFeeder :@

& Single-line Diagram X
Single-line Name:
BusbarFeeder Single-line Diagram... l@
Switchgear Properties: Preview
SG # Name Type
SG1 QA1 Controlled Make Break SG
(local_remote)
IL1 0A
QAl [ | ] 0OA
L3 0A

Single-line Error Messages:

@ Cancel I | Help

HPT_ZBG
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6.18

Programmable Logic via Smart view

Improper use of Logic Equations might result in personal injury or damage the electrical
equipment.

Do not use Logic Equations unless that you can ensure the safe functionality.

NOTICE!

It is recommended to configure the logic via Smart view (instead of the HMI of the
device).

S I I R
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Configuration of a Logic Equation

Enter the menu [Logics / LE x].

Launch the Logic Editor.

Set the Input Signals (where necessary, invert them).

If required, configure the timers (»LEx.t-On Delay« and »LEx.t-Off Delay«).

If the latched output signal is used assign a reset signal to the reset input »LEx.Reset
Latched«.

In case that Logic Equations should be cascaded the user has to be aware of timing
delays (cycles) in case of descending sequences (Please refer to section: Cascading
Logical Outputs).

Within the [Operation / Status Display / Logics], the user can check the status of the logical
inputs and outputs of the Logic Equation.
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6.19 Communication (SCADA)
Select the SCADA (Communication) Protocol

The set of available SCADA protocols depends on the ordered hardware variant (see the
Technical Manual of the HighPROTEC device). Note that (besides IRIG-B) always only one
protocol can be active at a time.

Therefore you have to define which one of the available SCADA protocols the HighPROTEC
device shall use. This is done by setting [Device planning] »Protocol« to the required
communication protocol.

After this, you have to make some more settings related to the selected protocol (see the
Technical Manual and/or Reference Manual of the HighPROTEC device).
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6.19.1 IEC 61850(*)

(*) = only available in devices that feature this protocol.

6.19.1.1 Generation/Export of a Device-Specific IID or ICD File

Each device of the HighPROTEC line includes a description of it's own functionality and
communications skills in form of an Instantiated IED Description (*.11D) or IED Capability
Description (*.1CD) file. This file can be exported as follows and be used for the configuration
of the substation.

NOTICE!

' A change of the device parameters has an influence on the content of the IID file.
®

1. > Connect the device with your PC/Notebook and start Smart view.

\Y

Select »Receive data from Device« from the [Device] menu.

3. > Navigate to the menu branch [Device Para / IEC 61850] or to [Device Para / IEC 61850 /
Communication], depending on the HighPROTEC Version.

4. > Click on the ICD icon in the IEC 61850 window.

5. > As of Version 3.10, HighPROTEC devices support both Edition 1 and Edition 2 of the
IEC 61850 protocol. In this case, the “File Type” input field allows for selecting between a
*.1ID file for Edition 1, a *.lID file for Edition 2, a *.ICD file for Edition 1, or a *.ICD file for
Edition 2. (For older versions, the choice is only between *.IID and *.ICD for Edition 1.)

Remark: For a typical commissioning, you will probably prefer an IID over an ICD.
(However, see also the Notice about file structure change below.)

Fill in the “File Name” input field and click “save”.

6. > Repeat the steps for all connected devices in this IEC 61850 environment.

NOTICE!

' There has been a change in the file structure:
o

As of version 5.30 of Smart view, an ICD file contains all Logical Nodes that the device
supports, including those that have been deactivated in the settings, whereas an IID file
contains only the Logical Nodes that are actually in use.

Note that earlier Smart view versions offered only to export an ICD file, but the exported
ICD file contained only the activated Logical Nodes, i. e. corresponded to what is an IID
file now.
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6.19.1.2 Generation/Export of an Example SCD File

Smart view can create an example SCD containing the functionality and communication
skills of the connected HighPROTEC device.

1. > Connect the device with your PC/Notebook and start Smart view.
Select »Receive data from Device« from the [Device] menu.

3. > Navigate to the menu branch [Device Para / IEC 61850] or to [Device Para / IEC 61850 /
Communication], depending on the HighPROTEC Version.

4. > Click on the SCD icon in the IEC 61850 window.

5. > As of Version 3.10, HighPROTEC devices support both Edition 1 and Edition 2 of the
IEC 61850 protocol. In this case, the “File Type” input field allows for selecting between
Edition 1 and Edition 2.

Fill in the “File Name” input field and click “save”.

\Y%
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6.19.1.3 Import the SCD File into the Device

When the substation configuration is completed, the SCD file has to be transmitted to all
connected devices. This is has to be done as follows:

v

Connect the device with your PC/Notebook and start Smart view.
Select »Receive data from Device« from the [Device] menu.

3. > Navigate to the menu branch [Device Para / IEC 61850] or to [Device Para / IEC 61850 /
Communication], depending on the HighPROTEC Version.

v

4. > Switch off the IEC 61850 communication (»Function« = “Inactive”) and submit the
changed parameter into the device.

5. > Click on the IEC icon in the IEC 61850 window.
Select the folder, where the SCD file is stored. Select the SCD file and click »Open«.

» The file is then read and checked.
As of Version 3.10, you should also check at the dropdown menu whether Edition 1 or
Edition 2 of the IEC 61850 protocol is needed. After changing the Edition the SCD file is
re-checked, and this also involves a comparison of the selected Edition with the internal
coding of the file.

v

7. > The configuration can be transmitted into the device if no internal fault is detected.
Press the button »Send Config.«.

As usual, you might be prompted for a password.

v

9. > Switch on again the IEC 61850 communication (»Function« = “Active”) and submit the
changed parameter into the device.

10. > Repeat the steps for all connected devices in this IEC 61850 environment.

» If no error message occurs, the configuration has been completed successfully.

When changing the substation configuration, usually a new .SCD file has to be
generated. This .SCD file has to be mandatory transmitted to all devices by means of
Smart view. For the case, that this step will be forgotten, IEC 61850 malfunctions will be
the result

Provided that parameters of the devices are changed after the substation configuration
completion, changes in the corresponding ICD file may result - this in turn may make an
update of the SCD file necessary.
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6.19.2 Configurable Communication Protocols(*)
Configurable Communication Protocols(*)

(*) = only available in devices that feature the protocols listed below and only for Version 3.6
and later.

Some of the SCADA protocols have an option to adapt the mapping of data objects to
the protocol-internal addresses to one's own needs. This can be done using a separate PC
software tool, SCADApter.
The protocols supporting such a re-mapping are currently as follows:
* |[EC 60870-5-104 (as of HighPROTEC Version 3.6)
¢ Modbus (as of HighPROTEC Version 3.6)
* Profibus (as of HighPROTEC Version 3.7)
* |[EC 60870-5-103 (as of HighPROTEC Version 3.7)

For detailed information, see the SCADApter documentation, and the respective protocol-
specific chapters in the Technical Manual of the HighPROTEC device.
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6.19.2.1 Data-Point Mapping Using the SCADApter

Software Tools

The setup procedure for a user-defined data-point mapping always works the same way
for all SCADA protocols that support user-defined mappings. A mapping of data objects is
always based on a separate file of file-type (extension) *.HptSMap. This file is edited with
a separate PC tool, SCADApter, and Smart view is used to download the currently active
user mapping from the protection device (for further editing), or to upload and activate the
edited new *.HptSMap mapping file.

NOTICE!

' The factory default mapping cannot be downloaded for further editing.
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Specify the Data-Point Mapping

The setting parameter [Device Para / protocol-name / Config. Data Obj.] »Type of SCADA
mapping« can be set to either “Standard” or to “User-defined”.

» “Standard” means that the protection device uses the factory-default as data-point
mapping (even if a user-defined mapping has already been uploaded to the Smart
view).

e “User-defined” means that the protection device uses the user-defined data-point
mapping. (If no valid mapping file has been uploaded then the device reports this by
setting the output value [Device Para / protocol-name / Advanced] »Update time« =
“Error 1/2".)

Transfer the Data-Point Mapping

If there is already a user-defined data-point mapping on the protection device, it is possible
to download it and use it for further editing. (The factory default cannot be downloaded.)

Depending on the value of »Type of SCADA mapping«, the active mapping is either the
factory default or a previously uploaded valid mapping file.

Both the download of a mapping file or a (later) upload of an edited mapping file has to be
done via Smart view, to which the protection device has to be connected.

After the Smart view connection has been established and all device data has been
retrieved, double-click the menu item [Device Para / protocol-name / Config. Data Obj.].

A dialog window is opened that features a »SCADA Configuration Transfer« button. (See (1)
in the example figure below.)

Clicking on this button opens another dialog, »SCADA Point Mapping Configuration«. There
are two buttons there, (2) and (a) in the figure below.

Button (a) performs the download: The protection devices sends its user-defined SCADA
protocol mapping to the »SCADA Point Mapping Configuration«, then a »Save as« file-dialog
appears, that allows the user to create a new *.HptSMap file from these protocol definitions.
(This download is not possible for the (factory default) standard mapping.)
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6.19.2.1 Data-Point Mapping Using the SCADApter
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@
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Example of using Smart view to transfer the *.HptSMap to the protection device.

Button (2), »Select a SCADA Mapping File from Disk and send it to the connected Device.
«, starts the upload of an edited mapping file. After clicking this button a file-select

dialog opens.

Then navigate to the *.HptSMap file that keeps the required SCADA definitions

and click »Openc«.

Smart view opens and checks the *.HptSMap file. If it is compatible with the connected
protection device a dialog asks the user whether the protocol definitions shall be transferred

to the protection device [(3) in the diagram].

After clicking »yes« (and entering the password for the access level »Supervisor-Lv3«) the
data is transferred, and the user is informed about the success (4).

The user may now click »Close« (5) in the »SCADA Point Mapping Configuration« dialog, to
return to the Smart view main window.

Finally the user-specific mapping must be activated by the setting [Device Para / protocol-
name / Config. Data Obj.] »Type of SCADA mapping« = “User-defined”.

Do not forget to transfer all (or all changed) settings (from Smart view) to the protection
device. Moreover, it is recommended to have the “Automatic Refresh” active within Smart
view, so that all entries within the [Config. Data Obj.] dialog get updated properly.
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6.19.3 Remote Configuration for Line Differential Protection Devices(*)

6.19.3 Remote Configuration for Line Differential Protection Devices(*)
(*) = only available in HighPROTEC devices with Line Differential Protection.

In case of two interconnected Line Differential Protection devices, Smart view also allows the
configuration of the remote device.

NOTICE!

' The “remote access” feature of the local Line Differential Protection device has to be set
o

to active.

NOTICE!

The TCP/IP ports in the range 52152 ... 52163 must not be blocked by a firewall, and
none of these ports must be used by any other (non-SEG) application.

1. > Connect the local device with your PC/Notebook and start Smart view.

N
\Y

Select »Receive data from Device« from the [Device] menu.

3. > After the connection is established a selection window for the local or remote device
appears.

4. > In this selection dialog, choose »Remote Devicex.

» The data of the remote device will be loaded.

The device data tree in Smart view is marked with a yellow frame whenever data of the
remote device is displayed.
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7 Operating a WIC1 (2nd Generation, via DiggiMEC)

7.1 Loading of Device Data when using Smart view

1. > Start Smart view.

2. > Make sure the connection has been established properly. (See -3.5 Connect a WIC1
(2nd Generation) via DiggiMEC.)

3. > Select »Receive Data from Device« in menu [Device].

D=0 P =g D=
| |

U atil ©EaEnEES)

DiggiMEC

Smart view

LN smart view =5 X
File Device Edit View Settings Tools Window Help

[y 2
DER ¥ ¥ 080
Shortcuts [ Device Data
4 wicl
Operation
[ Device planning
@ Device Para
Field Para
@® Protection Para

&= Service

Communication

WIC1_ZB9

Fig. 10:  After you have selected “Receive Data from Device”, Smart view presents the available
settings of the connected device.
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7.2

82
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Transfer Device Data from Smart view to the WIC1

Parameter modifications are indicated by a red asterisk (“*” symbol) in front of
the parameter.

The asterisk (in the device tree window) indicates that parameters in the opened file (within
Smart view) differ from parameters stored on your local hard disk.

Via the button »Transfer all parameters into the device«, you can transmit all parameters to
the device.

If a parameter file is saved on your local hard drive, these parameters are no longer
classified to be modified.

In order to (re-)transfer parameters into the device, please select »Transfer all
parameters into the device« in menu [Device].

Confirm the safety inquiry.
Enter the password for setting parameters in the popup window.
Thereafter the data is transferred to the device and adopted.

A confirmation dialog opens, asking you whether you want to save the changes into
a file. In general, this is recommended. Select a suitable folder on your hard disk and
click »Savex.

The parameter data are now saved in the folder chosen by you.
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7.3 Backup and Documentation when using Smart view

How to Save Device Data on a PC

0

1. > Click on »Save as ...« in menu [File].
2. > Specify a name and choose a folder on your hard disk.

3. > Save the device data accordingly.

Printing of Device Data when using Smart view (Setting List)

The printing menu of the Smart view software offers contextual different types of
printing ranges.

e Printing of the complete parameter tree:All values and parameters of the present
parameter file are printed.

* Printing of the displayed working window:

Only the data shown on the relevant working window are printed, i. e. this applies, if
at least one window is opened.

e Printing of all opened working windows:

The data shown on all windows are printed, i. e. this applies only if more than one
window is opened.

* Printing of the device parameter tree as from a shown position on:
All data and parameters of the device parameter tree are printed as from the

position/marking in the navigation window. Below this selection the complete name
of the marking is additionally displayed.
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Offline Device Planning via Smart view

The Smart view software enables also to parameterize offline. The advantage is: By using
device models you can do planning jobs for a device and set parameters in advance.

You can also read the parameter file out of the device, further process it offline (e.g. from
your office) and finally re-transfer it to the device.

You can either:

¢ |load an existing parameter file from a device (see <7.1 Loading of Device Data when
using Smart view).

* create a new parameter file (see below),
* open a locally saved parameter file (backup).

In order to create a new device/parameter file by way of a device template offline:

In order to create a new offline parameter file please choose within the menu [File] the
entry »Create new parameter file«.

A dialog window pops up. Please make sure that you select the right device type with
the correct version and configuration. [*1

Finally click on »Apply«.
In order to save the device configuration select »Save« out of the [File] menu.

Within the menu [Edit / Modify Device Configuration (Typecode)] you can modify the
device configuration or simply find out the type code of your current selection.

For the transfer of the parameter file into a device, see 7.2 Transfer Device Data from
Smart view to the WIC1.

[*1 For the WICL1 in particular, there are dependencies between the entries for the device
configuration. This means that not all combinations are valid. Smart view handles this

in a general and maybe surprising way (that is also used when configuring a parameter
makes another parameter unavailable, »“Plausibility check”): Whenever changing an entry
makes another entry invalid there is no automatical modification of this invalid entry. This is
intentional, because such a change can result in unwanted setting without the user noticing
this. Instead, the invalid entry is marked by a red question mark at the left margin, and the
dialog window (i. e. the device type) cannot be successfully closed. The user is expected to
double-click each invalid entry, so that an edit dialog opens. This edit dialog presents only
the valid setting(s), and the user has to explicitly accept by clicking »OKx.
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7.5 Measuring Values

Measuring Values

Read out of Measured Values via Smart view

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

In the navigation tree, go to [Operation / Measured Values], double-click any sub-menu.

The measured and calculated values (from the selected sub-menu) are shown now in
tabular form.

As of WIC1 g2 Version 2.0: For each of the sub-menus [Peak Current Ptr] (Statistic of the
current measuring values) and [Life Load] (Load Current Histogram), it is also possible to
select a graphical display as a diagram.

To have the measuring data read in a cyclic manner, select »Auto refresh« in menu
[View]. The measured values are read out about every two seconds.

The »Auto refresh« feature, however, always only keeps the [Operation] menu branch of
the device (i. e. measured values, states, etc.) updated. It is not for retrieving settings
(that might have been changed directly at the WIC1 via DIP/HEX switches). The settings
are only retrieved (again) by pressing the key »F2« at the PC (or Smart view menu item
“Receive Data from Device”), see =7.1 Loading of Device Data when using Smart view.
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7.6 Status Display via Smart view

1. > If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

2. > In the navigation tree, go to [Operation / Status Display], double-click any sub-menu.

» The status of all signals (from the selected sub-menu) are shown now in tabular form.

' To have the data read in a cyclic manner, select »Auto refresh« in menu [View]. The
o

measured values are read out about every two seconds.

Signal State / Module Input Display within Smart view
false / »0« 0
true / »1« 1
No connection to the device or busy. ?
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7.7 Recorders

Check Fault Records via Smart view

1. > Ifthe device data were not yet loaded - select »Receive Data from Device« from menu

[Device].
. > Double click the »Operation« icon in the navigation tree.
. > Navigate to the menu branch [Operation / Recorders] and double-click on »Fault rec«.
» Inthe window the fault records are shown in tabular form.
4. > Double click any of the fault records that are listed in this table.
» A new window opens, that lists various details for this record, in particular all
measurement values.
CAUTION!
There is no real-time clock available with the WIC1. Therefore each Fault Record is
labeled with a timestamp relative to the runtime of the WIC1, that is the duration since
the last (warm or cold) restart, plus (in parentheses) the total number of WIC1 restarts.
Via the print menu you can export the data into a file. Please proceed as follows:
£
1. > Open the data as described above.
2. > Press the button »Print«.
3. > Press the button »Export to File«.
4. > Enter a file name.
5. > Choose a location where to save the file.
6. > Press the button »Save«.
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Parameters
Change a Parameter via Smart view - Example

Example: Changing of a protective parameter - We want to alter the characteristic for the
overcurrent protection function »I>«.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double-click the icon »Protection Para« in the navigation tree.
Double-click »I>«.

In the dialog window a tabulated overview appears, showing the parameters assigned to
this protective function.

In this table double-click the value/parameter you want to change (here: »Char«).
An editing dialog window is opened where you can select the required characteristic.
Close this window by clicking the »OK« button.

Additional parameters can be changed if required. [*]

Select the menu item [device / Transfer all parameters to the device]. (See also <7.2
Transfer Device Data from Smart view to the WIC1.)

In the confirmation dialog, accept that the parameters be overwritten.
Afterwards the parameters are transferred to the protection device.

Another confirmation dialog opens, asking you whether you want to save the changes
into a file. In general, this is recommended. Select a suitable folder on your hard disk
and click »Save«.

The changed parameter data is now saved in the folder chosen by you.

NOTICE!

An asterisk (“*” symbol) in front of the changed parameters indicates that the alterations
have not yet been stored in a parameter file. This is independent of whether the
parameters have been transferred to the device in the meantime.

In order to make things easier to follow, especially where complex parameter changes
are involved, the menu tree indicates the parameter change by the asterisk on every
superior/higher menu level, too (“star trace”). This makes it possible to control or follow
up from the main menu level at any time where parameter changes have been made but
not been saved yet.

The “star trace” is cleared only if the parameter changes are saved in a parameter file,
or if all device data is reloaded from the device.

88

[*1 Sometimes there are dependencies between parameters. This means that changing a
setting can make another parameter valid. Then Smart view marks all invalid parameters
by a red question mark at the left margin, and the transfer of the settings to the device

is refused. The user is expected to double-click each invalid parameter. This editing dialog
presents only the valid setting(s), and the user has to explicitly accept by clicking »OK«.
(See also =“Plausibility check”.)
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7.8.1 Parameter Files

Parameter Files

Parameter files for the 2"d generation WIC1 have the extension *.WiPara and store all
settings of a WIC1 protection device.

A WiPara file is always related to a device model.
Therefore you have two alternative principles for the creation of a new configuration file:

* Creating a *.WiPara offline, i. e. without being connected to a protection device.

In this case Smart view opens selection dialogs, asking you to specify the exact
device and typecode for which the configuration shall be made. (The “typecode”,
also called “order code”, defines the particular device variant, including housing and
communication options.)

In the typecode dialog, it is possible to double-click every specification line (or
highlight it and click the »Edit« button) and adapt the entry to your particular device.
Alternatively, you can also click the “pencil” button and directly type in the letters
and digits of your device's typecode.

You can find the typecode printed as “CAT No.” on the adhesive label that is glued to
the housing of the protection device.

Creating a *.WiPara while being connected to a WIC1 (via DiggiMEC). In this case
Smart view defines all settings for this particular device, and immediately after
having retrieved the data from the device Smart view asks you whether you want
to save them into a new WiPara file. (Of course it is possible to re-use the WiPara
file later for another protection device, provided the variant and firmware version
(release) are identical.)

With an established connection, you can also check the value of [Device Para /
Version] »CAT No.«.

And finally, you can use the Smart view menu »[File = Properties]« to open a window
that displays various information, including the typecode.

Working with Parameter Files

You have essentially the same possibilities when working with WIC1 parameter files
(*.WiPara), as with HighPROTEC parameter files (*.HptPara), which are described here:
<6.11.1 Parameter Files
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7.9 Version via Smart view

Within the menu [File / Properties] you can obtain detailed information on the currently
opened file like e. g. software and hardware version.
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7.10 Display of ANSI-Codes

It is possible to make Smart view display ANSI codes:

0

1. > Within the menu [Settings], tick the checkbox »Display ANSI device numbers«.
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Graphical Display of Tripping Characteristics

Smart view supports the graphical display of tripping characteristics. Depending on the
device type and the device configuration various tripping characteristics and related
characteristics can be displayed.

* Phase Overcurrent Tripping Characteristics (ANSI, IEC,...)

* Ground (Earth) Overcurrent Tripping Characteristics (ANSI, IEC,...)

Example - Graphical Visualization of the Overcurrent Tripping
Characteristic »I1>«

If the device data/parameters are not loaded yet, please load them from the device or
open a file.

Within the navigation tree, enter the menu branch [Protection Para / I>].
Double-click on the protective element »I>«.

A dialog window is opened that shows all the parameters in tabular form that are tied to
this protective element.and that define the tripping characteristic.

(-
Click on the icon »View Characteristic« within the toolbar of this window: 1"""

A new window now shows the graphical visualization of the selected tripping
characteristic.

Adding and Removing Tripping Characteristics to the Visualization

Additional tripping characteristics of further protective elements and protection sets can be
added to the visualization.

Example: Adding Additional Curves to the Visualization of the Tripping
Characteristic »I1>«

Open, as described in the example above, the window for the visualization of the
tripping characteristic of the protective element »1>«.

Click within the toolbar of this diagram window on the icon »Add/Remove Curves...«:
&y
A selection window pops up. There you can select:

¢ Which protective elements should be displayed additionally. (Only available, if more
than one protective element of the same type is projected.)
Select those curves, that you want to add to the current visualization.
Close the selection window by a click on »Apply«.

The graphical visualization is updated, so that the additionally selected curves are
shown.

Smart view SMARTV-5.50-EN-MAN



8 Operating a HighTECH Line Device

8.1 Loading of Device Data when using Smart view

8 Operating a HIghTECH Line Device

8.1 Loading of Device Data when using Smart view

1. > Start Smart view.

2. > Make sure the connection has been established properly. (See -3.6 Connect a HighTECH
Line Device.)

3. > Connect your PC with the device.

4. > Select »Receive Data from Device« in menu [Devicel.

ENTER
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File Device Edit View Settings Tools Window Help
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Ehortclts [ Device Data

Operation
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Fig. 11: After you have selected “Receive Data from Device”, Smart view presents the available
settings of the connected device.
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8.2 Transfer Device Data from Smart view to the Device

Via the button »Transfer only modified parameters into the device« only modified
parameters are transmitted into the device.

Parameter modifications are indicated by a red asterisk (“*” symbol) in front of the
parameter.

The asterisk (in the device tree window) indicates that parameters in the opened file
(within Smart view) differ from parameters stored on your local hard disk.

Via the button »Transfer only modified parameters into the device«, you can transmit all
parameters that are marked by this symbol.

If a parameter file is saved on your local hard drive, these parameters are no longer
classified to be modified and cannot be transmitted via the button »Transfer only
modified parameters into the devicex.

In case that you have loaded and modified a parameter file from the device and saved it
to your local hard drive without transferring the parameters into the device beforehand,
you cannot use the button »Transfer only modified parameters into the device«. In a case
like that, use »Transfer all parameters into the device«.

NOTICE!

The button »Transfer only modified parameters into the device« only works if modified
parameters are available in the Smart view.

In contrast to that, all parameters of the device are transferred when the
button »Transfer all parameters into the device« is pressed (unless there are invalid or
implausible device parameters, see <“Change a Parameter via Smart view - Example”).

1. > In order to (re-)transfer changed parameters into the device, please select »Transfer all
parameters into the device« in menu [Device].

Confirm the safety inquiry »Shall the parameters be overwritten into the device?«.
Enter the password for setting parameters in the popup window.

Thereafter the changed data is transferred to the device and adopted.

v v .V V

A confirmation dialog opens, asking you whether you want to save the changes into
a file. In general, this is recommended. Select a suitable folder on your hard disk and
click »Save«.

p The changed parameter data is now saved in the folder chosen by you.
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8.3 Backup and Documentation when using Smart view

How to Save Device Data on a PC

0

1. > Click on »Save as ...« in menu [File].
2. > Specify a name and choose a folder on your hard disk.

3. > Save the device data accordingly.

Printing of Device Data when using Smart view (Setting List)

The printing menu of the Smart view software offers contextual different types of
printing ranges.

e Printing of the complete parameter tree:All values and parameters of the present
parameter file are printed.

* Printing of the displayed working window:

Only the data shown on the relevant working window are printed, i. e. this applies, if
at least one window is opened.

e Printing of all opened working windows:

The data shown on all windows are printed, i. e. this applies only if more than one
window is opened.

* Printing of the device parameter tree as from a shown position on:
All data and parameters of the device parameter tree are printed as from the

position/marking in the navigation window. Below this selection the complete name
of the marking is additionally displayed.
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1. >

Offline Device Planning via Smart view

The Smart view software enables also to parameterize offline. The advantage is: By using
device models you can do planning jobs for a device and set parameters in advance.

You can also read the parameter file out of the device, further process it offline (e.g. from
your office) and finally re-transfer it to the device.

You can either:

* |load an existing parameter file from a device (see =8.1 Loading of Device Data when
using Smart view).

* create a new parameter file (see below),
* open a locally saved parameter file (backup).

In order to create a new device/parameter file by way of a device template offline:

In order to create a new offline parameter file please choose within the menu [File] the
entry »Create new parameter file«.

A dialog window pops up. Please make sure that you select the right device type and
version.

In order to save the device configuration select »Save« out of the [File] menu.

For the transfer of the parameter file into a device, see 8.2 Transfer Device Data from
Smart view to the Device.
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8.5 Measuring Values

Read out of Measured Values via Smart view

1. > In case Smart view is not running - please start it.

2. > If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

3. > Double click on icon »Operation« in the navigation tree.
4. > Double click on icon »Measured Values« within the navigation tree [Operation].

5. > Within the »Measured Values«, double click the category of measured values that you
are interested in.

p» The measured and calculated values are shown now in tabular form.

' To have the measuring data read in a cyclic manner, select »Auto refresh« in menu

[View]. The measured values are read out about every two seconds.
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8.6 Status Display via Smart view

1. > In case Smart view is not running - please start it.

2. > If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

3. > Double click the »Operation« icon in the navigation tree.

4. > Double click the icon »STATUS« within the menu [Operation].

NOTICE!

' To have the data read in a cyclic manner, select »Auto refresh« in menu [View]. The
®

measured values are read out about every two seconds.

Signal State / Module Input Display within Smart view
false / »0« 0
true / »1« 1
No connection to the device or busy. ?
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Recorders

Check Disturbance Records via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double click the »Operation« icon in the navigation tree.

Navigate to the menu branch [Operation / Recorders] and double-click on »Disturb rec«.
In the window the disturbance records are shown in tabular form.

Double-click any disturbance record and choose a folder where it is to be saved to.

You can analyze the disturbance records using the software DataVisualizer after clicking
on »Yes« when you are asked “Shall the received disturbance record be opened by the
DataVisualizer?”

Delete Disturbance Records via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Devicel].

Double click the »Operation« icon in the navigation tree.
Navigate to the menu branch [Operation / Recorders] and double-click on »Disturb rec«.
In the window the disturbance records are shown in tabular form.

In order to delete a disturbance record double-click on: » X« (the red x) in front of the
disturbance record and confirm.

Check Fault Records via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double click the »Operation« icon in the navigation tree.
Navigate to the menu branch [Operation / Recorders] and double-click on »Fault rec«.

In the window the fault records are shown in tabular form.

Via the print menu you can export the data into a file. Please proceed as follows:
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0

1. > Open the data as described above.

2. > Press the button »Print«.

3. > Press the button »Export to File«.

4. > Enter a file name.

5. > Choose a location where to save the file.
6. > Press the button »Save«.
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Parameters
Change a Parameter via Smart view - Example

Example: Changing of a protective parameter. (We want to alter the characteristic for the
overcurrent protection in parameter set 1).

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

Double-click the icon »PROTECTION SETTINGS« in the navigation tree.
Within the [PROTECTION SETTINGS] menu, double-click the icon »Set 1«.

In this table double-click the value/parameter you want to change (here: »CHAR I>
Characteristics«).

An editing dialog window is opened where you can select the required characteristic.
Close this window by clicking the »OK« button.
Additional parameters can be changed if required.

There are two options available within the menu [device]: Transfer all parameters to the
device, or only the modified ones. See -8.2 Transfer Device Data from Smart view to the
Device.

In the confirmation dialog, accept that the parameters be overwritten.

An asterisk (“*"” symbol) in front of the changed parameters indicates that the alterations
have not yet been stored in a parameter file. This is independent of whether the
parameters have been transferred to the device in the meantime.

In order to make things easier to follow, especially where complex parameter changes
are involved, the menu tree indicates the parameter change by the asterisk on every
superior/higher menu level, too (“star trace”). This makes it possible to control or follow
up from the main menu level at any time where parameter changes have been made but
not been saved yet.

The “star trace” is cleared only if the parameter changes are saved in a parameter file,
or if all device data is reloaded from the device.

Switch Setting Groups (Parameter Sets) via Smart view

In case Smart view is not running - please start it.

If the device data were not yet loaded - select »Receive Data from Device« from menu
[Devicel].

Double-click the icon »Protection Para« in the navigation tree.

Within the [Protection Para] menu, double-click the icon »PS«.
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5. > Configure the Setting Group Switch respectively choose an active set manually.
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8.9 Synchronize Date and Time via Smart view

1. > In case Smart view is not running - please start it.

2. > If the device data were not yet loaded - select »Receive Data from Device« from menu
[Device].

3. > Within the navigation tree, enter »Date and Time«, which is in the menu branch [Device
Para / Time]. Double-click this entry.

» A dialog opens that shows the current date and time of both PC and device.
4. > Click on the button »Synchronize«.

p The device receives and takes over date and time from the PC.
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8.10 Version via Smart view

Within the menu [File / Properties] you can obtain detailed information on the currently
opened file like e. g. software and hardware version.
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